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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]

SUP. BURKE, CHAIR: THE MEETING WILL PLEASE COME TO ORDER. THE INVOCATION WILL BE BY THE REVEREND TERRY KEENAN, SANTA ANITA CHURCH IN ARCADIA. THE PLEDGE BY FRED S. RODRIGUEZ, LIFE MEMBER OF AMERICAN G.I. FORUM, SANTA FE SPRINGS FROM THE FOURTH DISTRICT. WILL YOU PLEASE STAND? 

REVEREND TERRY KEENAN: WOULD YOU PLEASE, IF YOU WOULD, CLOSE YOUR EYES AND JOIN ME IN A BRIEF PRAYER? WE THANK YOU FOR THIS DAY, AND FOR THE OPPORTUNITIES YOU GIVE US TO DEMONSTRATE YOUR LOVE THROUGH OUR ACTIONS. WE THANK YOU FOR THIS PLACE WE LIVE, AND FOR THE CHANCES YOU GIVE US TO IMPROVE IT WITH OUR HANDS FOR YOUR ENJOYMENT AS WELL AS OURS. WE THANK YOU FOR OUR CHILDREN AND OUR PARENTS. TEACH US TO ALWAYS LOVE AND PROTECT THEM THROUGH YOUR GUIDANCE AND GRACE. IN THESE TIMES WHEN WE FACE SO MANY CHALLENGES, WHEN THERE IS LACK AND EVERYTHING COSTS MORE, HELP US TO COME TOGETHER IN PEACE TO SEEK SOLUTIONS FOR OUR COMMON GOOD. HELP US TO EXPRESS YOUR LOVE THROUGH OUR CHOICES AND DECISIONS, THAT WE MAY BRING ALL PEOPLE INTO THE DANCE OF LIFE ONE FAMILY, ONE HOLY SOURCE. TEACH US TO LIVE IN PEACE AND CELEBRATE TOGETHER IN ONE GREAT CIRCLE OF LOVE. AMEN. 

FRED S. RODRIGUEZ: PLACE YOUR HAND OVER YOUR HEARTS PLEASE AND FACE THE FLAG. [ PLEDGE OF ALLEGIANCE ] 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: AS YOU STATED, PASTOR TERRY KEENAN IS THE SENIOR MINISTER AT THE SANTA ANITA CHURCH AND IS ALSO A CHAPLAIN FOR THE LOS ANGELES COUNTY SHERIFF  DEPARTMENT AND THE ARCADIA POLICE DEPARTMENT. HE IS A RETIRED LOS ANGELES COUNTY SHERIFF'S DEPUTY AND HE'S BEEN A SPOKESPERSON FOR THE COUNTY-WIDE SHERIFF'S RECRUITMENT VIDEOS, COMMERCIALS AND HAS APPEARED IN A NUMBER OF VIDEOS ON TERRORIST ACTIVITIES WHICH HAVE BEEN MADE BY THE LOS ANGELES POLICE DEPARTMENT, LOS ANGELES COUNTY SHERIFF  DEPARTMENT, AND THE FEDERAL BUREAU OF INVESTIGATIONS, THE F.B.I. SO PASTOR KEENAN, THANK YOU FOR COMING DOWN AND LEADING US IN PRAYER. [ APPLAUSE ] 

SUP. BURKE, CHAIR: SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD. IT'S MY PLEASURE TO PRESENT A CERTIFICATE OF APPRECIATION TO MR. FRED RODRIGUEZ. HE IS A LIFE MEMBER OF THE AMERICAN G.I. FORUM IN SANTA FE SPRINGS AND PRESIDENT AND C.E.O. OF VETERANS IN COMMUNITY SERVICES. HE SERVED IN THE UNITED STATES AIR FORCE FROM 1955 TO '59 AS AIRMAN SECOND CLASS WITH THE 11TH COMMUNICATIONS SQUADRON. HE ALSO PARTICIPATED IN THE HUNGARIAN AIRLIFT. HE HAS RECEIVED THE UNITED STATES AIR FORCE GOOD CONDUCT MEDAL AND THE NATIONAL DEFENSE SERVICE MEDAL. AFTER THE MILITARY, HE ATTENDED COLLEGE BOTH AT U.S.C. AND PEPPERDINE. HE LIVES IN THE GREAT CITY OF WHITTIER AND HAS LIVED IN THE FOURTH DISTRICT FOR OVER 20 YEARS. HE'S MARRIED WITH THREE CHILDREN. SO ON BEHALF MYSELF AND MY COLLEAGUES, WE'D LIKE TO SAY THANK YOU FOR TAKING THE TIME TO COME DOWN AND LEAD US IN THE PLEDGE OF ALLEGIANCE. [ APPLAUSE ] 

CLERK SACHI HAMAI: GOOD MORNING, MADAM CHAIR, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 4, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION. ON ITEM 1-D, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. THE REMAINING ITEMS, 2-D THROUGH 5-D, ARE BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON PAGE 7, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY. ON ITEM 2-H, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON PAGE 11, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 17. ON ITEM NUMBER 12, SUPERVISOR KNABE AND A MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: PAGE 15, CONSENT CALENDARS -- CONSENT CALENDAR, EXCUSE ME, ITEMS 18 THROUGH 92. ON ITEM NUMBER 32, THIS ITEM SHOULD HAVE BEEN PLACED UNDER SEPARATE MATTERS AS IT NEEDS ITS OWN VOTE. SO WE WILL TAKE THIS ITEM UP AFTER WE FINISH WITH THE CONSENT CALENDAR. ON ITEM NUMBER 36, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO MAY 13TH, 2008. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION. 

CLERK SACHI HAMAI: ON ITEM NUMBER 38, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 39, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 48, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 52, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 53, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO MAY 13TH, 2008. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION, ONE WEEK. 

CLERK SACHI HAMAI: ON ITEM NUMBER 55, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 58, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ITEM NUMBER 59, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 79, SUPERVISOR MOLINA VOTES "NO" ON THIS ITEM. ON ITEM NUMBER 80, SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE HELD. ON ITEM NUMBER 84, SUPERVISOR MOLINA REQUESTS THAT THE SETTLEMENT BE APPROVED TODAY BUT TO CONTINUE THE CORRECTIVE ACTION PLAN FOR TWO WEEKS TO MAY 20TH, 2008. ON ITEM 87, SUPERVISOR MOLINA REQUESTS THAT THE SETTLEMENT BE APPROVED TODAY BUT THE CORRECTIVE ACTION PLAN BE CONTINUED ONE WEEK TO MAY 13TH, 2008. AND THE REMAINING ITEMS ON THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. MOVED BY KNABE, SECONDED BY ANTONOVICH. AND WITH THE EXCEPTIONS THAT 84, THE CORRECTIVE ACTION PLAN IS CONTINUED TO? 

CLERK SACHI HAMAI: MAY 20TH. 

SUP. BURKE, CHAIR: MAY 20TH. AND ON 87, THE CORRECTIVE PLAN IS CONTINUED ONE WEEK. ALSO, SUPERVISOR MOLINA IS RECORDED AS "NO" ON 79. SECONDED BY KNABE. WITHOUT OBJECTION, WITH THOSE EXCEPTIONS. 

CLERK SACHI HAMAI: THANK YOU. ON ITEM 32, IF WE COULD GO BACK TO THIS ITEM, AND I'LL READ THE TITLE IN FOR THE RECORD. THIS IS THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING ISSUANCE AND SALE OF THE SAN GABRIEL UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS ELECTION SERIES 2008, SERIES A IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $22 MILLION. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: WE'RE NOW ON PAGE 42, ORDINANCES FOR INTRODUCTION. ON ITEMS 93 AND 94, I'LL READ THE SHORT TITLE IN FOR THE RECORD. ON ITEM 93, THIS IS AN ORDINANCE AMENDING TITLE 5, PERSONNEL, OF THE LOS ANGELES COUNTY CODE RELATING TO TRAVEL EXPENSES FOR THE COMMUNITY ACTION BOARD. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ITEM 94, THIS IS AN ORDINANCE AMENDING TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE RELATING TO THE IMPLEMENTATION OF A CERTIFICATION BONUS IN THE DEPARTMENT OF REGIONAL PLANNING. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: DISCUSSION ITEMS, ITEMS 95 AND 96. ON ITEM NUMBER 95, WE WILL HOLD FOR A DISCUSSION. ON ITEM NUMBER 96, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 4TH, 2008, AND THERE'S ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. BURKE, CHAIR: WE'LL HOLD IT. 

CLERK SACHI HAMAI: MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM 97-A, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 97-B. 

SUP. BURKE, CHAIR: MOVED BY BURKE, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 97-C. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH. SECONDED BY MOLINA, WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 97-D. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 97-E. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH. SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 97-F. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: 97-G. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON PAGE 46, NOTICES OF CLOSED SESSION. ON ITEM CS-3, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NUMBER ONE. 

SUP. BURKE, CHAIR: I HAVE STARS. ALL RIGHT. THIS IS SPECIAL BECAUSE WE ARE HONORING THE VERY FIRST RECIPIENT OF L.A. COUNTY SUPERSTARS, THE ANNUAL EMPLOYEE RECOGNITION PROGRAM. AND THIS IS A COMPONENT OF L.A. COUNTY STARS. IT'S ESPECIALLY FITTING TO RECOGNIZE THESE TEAMS AND INDIVIDUALS TODAY AS WE JOIN THE NATION IN CELEBRATING PUBLIC SERVICE RECOGNITION WEEK. IT IS MY PLEASURE TO INTRODUCE THE 2007 L.A. COUNTY SUPERSTARS. IN THE CATEGORY OF SERVICE EXCELLENCE, PLEASE WELCOME THE WEB SERVICE UNIT FROM THE OFFICE OF THE ASSESSOR. THE TEAM, COMPRISED OF YVONNE RODRIGUEZ, DARLENE DEL PELASSIO, REX HEARTLAND, AMY CHIN, HARRY LEE, AND LISA GIBB FOR CREATING OUTSTANDING PUBLIC SERVICE WEBSITE THAT DIRECTS TAXPAYERS TO PROPERTY TAX-RELATED INFORMATION. THIS ELIMINATED THE NEED FOR TAXPAYERS TO HAVE TO CONTACT FOUR DIFFERENT DEPARTMENTS IN ORDER TO RECEIVE A RESPONSE TO THEIR INQUIRIES. THE TEAM ALSO WROTE THEIR OWN EMAIL-BASED MONITORING SOFTWARE TO ENSURE 24-HOUR FUNCTIONALITY OF THE WEB SITE AND TO ELIMINATE PERSONAL AFTER HOURS MONITORING BY SUPPORT STAFF. CONGRATULATIONS. [APPLAUSE] THANK YOU FOR ALL YOUR GOOD WORK. PLEASE WELCOME DR. DAVID JACOBSON, DEPUTY DIRECTOR, CHILD SUPPORT SERVICES, DEPARTMENT INFORMATION TECHNOLOGY BUREAU, AS THE 2007 INDIVIDUAL WINNER OF L.A. COUNTY SUPERSTARS IN THE CATEGORY OF WORK FORCE EXCELLENCE. MR. JACOBSON WAS THE DRIVING FORCE BEHIND THE TRANSFER OF THE DEPARTMENT'S 475,000 CASE ACCOUNTS TO THE NEW STATE DISBURSEMENT UNIT IN FURTHERANCE OF CALIFORNIA'S CHILD SUPPORT AUTOMATION PROJECT. ADDITIONALLY, HE WAS A KEY PLAYER IN THE CONVERSION OF OVER 200,000 ORANGE AND SAN DIEGO COUNTY CASES WITH MORE THAN 1 BILLION IN RECEIVABLES TO THE LOS ANGELES CHILD SUPPORT COMPUTER SYSTEM, SAVING MILLIONS IN STATE FUNDS. MR. JACOBSON IS A TRUE COLLABORATOR WHO COORDINATES THE LOS ANGELES CHILD SUPPORT CONSORTIUM. THIS IS A THREE-COUNTY GOVERNANCE SYSTEM HOSTING DATA FROM ORANGE COUNTY, SAN DIEGO, AND LOS ANGELES COUNTIES, MAKING IT THE SIXTH LARGEST CHILD SUPPORT COMPUTER OPERATION IN THE NATION. HE IS AN I.T. PROFESSIONAL WHO ADVOCATES FAMILY FIRST IN TERMS OF BOTH POLICY AND AUTOMATION. NO AUTOMATION CHALLENGE IS TOO GREAT FOR MR. JACOBSON, AND THOUSANDS OF LOS ANGELES FAMILIES BENEFIT EVERY DAY FROM HIS DEDICATION, EFFORT AND SUPERSTAR QUALITY. CONGRATULATIONS, MR. JACOBSON. [ CHEERS AND APPLAUSE ] 

SUP. BURKE, CHAIR: YOU HAVE A LOT OF SUPPORTERS OUT THERE. IN THE CATEGORY OF ORGANIZATIONAL EFFECTIVENESS, THE INDIVIDUAL RECIPIENT IS SUSAN HIVAND FROM THE DEPARTMENT OF MENTAL HEALTH. ON SATURDAY, DECEMBER 16TH, 2006, THE BUILDING HOUSING THE SANTA CLARITA VALLEY MENTAL HEALTH CENTER SUFFERED SIGNIFICANT DAMAGE DUE TO A FIRE, AND WAS DECLARED UNUSABLE. WORKING CLOSELY WITH THE PROGRAM HEAD, DISTRICT CHIEF, AND DEPUTY DIRECTOR, MISS HIVAND ENSURED SERVICES WOULD NOT BE INTERRUPTED. TWO DAYS AFTER THE FIRE, THE CLINIC WAS OPEN FOR BUSINESS IN A TEMPORARY LOCATION. MISS HIVAND WAS INSTRUMENTAL IN ENSURING ALL STAFF KNEW WHERE TO REPORT AND FACILITATE EMERGENCY SUPPLIES TO SET UP THE TEMPORARY SPACE. THE FIRE DEVASTATED MOST OF THE STAFF. HOWEVER, MISS HIVAND WAS INSPIRATIONAL IN APPROACHING STAFF INDIVIDUALLY AND COLLECTIVELY, ENCOURAGED THEM TO LOOK AT THE SITUATION AS AN OPPORTUNITY TO IMPROVE SERVICE AND IMPROVE THE WAY BUSINESS WAS CONDUCTED. SHE WAS NEVER FRUSTRATED WITH MULTIPLE PROBLEMS THAT PRESENTED THEMSELVES ON A DAILY BASIS AND ACTED AS IF THERE WERE NO CHALLENGE THAT COULD NOT BE SURMOUNTED. THE END RESULT WAS STAFF BEGAN TO GIVE SUGGESTIONS FOR IMPROVEMENTS IN TERMS OF ORGANIZATIONAL FLOW. THIS COLLABORATION ASSISTED IN PROVIDING NEW IDEAS ON IMPROVING SERVICE TO THE COMMUNITY AND DOING BUSINESS IN A MORE EFFICIENT MANNER. CONGRATULATIONS, AND I WANT TO BE SURE, DID I PRONOUNCE YOUR NAME RIGHT? I DID. GOOD. CONGRATULATIONS. [ APPLAUSE ] FOR THE TEAM RECIPIENT IN THE CATEGORY OF ORGANIZATIONAL EFFECTIVENESS, PLEASE WELCOME THE EL MONTE ANNEX EMERGENCY REDEPLOYMENT/RESPONSE TEAM FROM THE DEPARTMENT OF PUBLIC SOCIAL SERVICES AND INTERNAL SERVICES DEPARTMENT. AN EARLY MORNING FIRE AT THE D.P.S.S. EL MONTE ANNEX OFFICE ON MAY 31ST, 2007, RENDERED THE 6-STORY MULTI-TENANT FACILITY UNINHABITABLE. THIS NECESSITATED THE REEMPLOYMENT OF OVER 500 COUNTY EMPLOYEES FROM D.P.S.S., HEALTH SERVICES, HUMAN SERVICES OPERATION OF D.P.S.S. WERE MOMENTARILY SUSPENDED. IN HOME SERVICES, THE CUSTOMER SERVICE CALL CENTER AND THE MEDI-CAL OUTREACH AND EMERGENCY RESPONSE PLAN HAD TO BE IMMEDIATELY DEVELOPED AND IMPLEMENTED TO ENSURE THAT SERVICE TO SOME OF THE MOST VULNERABLE PARTICIPANTS WERE NOT COMPROMISED. KEY STAFF FROM D.P.S.S. AND I.S.B. CAME TOGETHER ON FRIDAY, JUNE 1ST, 2007, COMMITTED TO ESTABLISHING AN ACTION PLAN WITH A GO-LIVE TIMELINE WITHIN 72 HOURS. THE PLAN WAS FULLY DEVELOPED WITH KEY STAKEHOLDERS, INCLUDING FULL NEEDS ASSESSMENT AND LOGISTIC REQUIREMENTS IN THE SPAN OF FOUR HOURS. D.P.S.S. AND I.S.D. STAFF WORKED FRIDAY, SATURDAY, AND SUNDAY, 14 HOURS A DAY, TO ACHIEVE THE DESIRED OUTCOME. AS A RESULT, THERE WERE NO INTERRUPTIONS IN SERVICES FOR ANY OF THE PARTICIPANTS. THIS COLLABORATION DEMONSTRATED THAT WORKING TOGETHER, TWO COUNTY DEPARTMENTS COULD CREATE THE BEST OF ALL WORLDS DURING AN EMERGENCY. TEAM MEMBERS INCLUDE MICHELLE CALLAHAN, JOHN ARMOR, JOEL FLORES, FRANK REYES, WALDO SALAZAR, MICHAEL CORNELIUS, MIKE HOLMAN, ROBERT MENGEL, EDWIN MORALES, PENNY KING-YOUNGER, LOREEN CLEVELAND, RALPH RODRIGUEZ, RICHARD BANKS, JAMES CHAPMAN, GLEN ALOPAG, NARINDER KUMAR, JOSEPH RAMBILA, RUDY RAMOS, JOHN RUDLING, GARY ECOPIAN, JOSE HERNANDEZ, DANIEL GARCIA, STEVEN GANG, AND HENRY AVINDEN. CONGRATULATIONS AND YOU DID SUCH A WONDERFUL, WONDERFUL JOB. THANK YOU. [ APPLAUSE ] 

SUP. BURKE, CHAIR: THANK YOU SO MUCH. CONGRATULATIONS. LAST BUT NOT LEAST IS THE RECIPIENT FOR THE 2007 L.A. COUNTY SUPERSTARS IN THE CATEGORY OF FISCAL RESPONSIBILITY. PLEASE WELCOME THE 2007 FIRE FIGHTER TRAINEE EXAM TEAM FROM THE FIRE DEPARTMENT, THE DEPARTMENT OF HUMAN RESOURCES, AND THE INTERNAL SERVICES DEPARTMENT. THE FIRE DEPARTMENT WAS MOTIVATED TO DELIVER AN OUTSTANDING FIRE FIGHTER TRAINEE EXAM WHILE REDUCING THE ONE MILLION EXPENSE INCURRED WITH THE 2005 EXAM. SEEKING TO UTILIZE BEST PRACTICES IN RECRUITMENT AS WELL AS INFORMATION SYSTEMS, THE FIRE DEPARTMENT COLLABORATED WITH THE DEPARTMENT OF HUMAN RESOURCES AND THE INTERNAL SERVICES DEPARTMENT. THE CORE TEAM CONSISTED OF SIX FIRE DEPARTMENT EMPLOYEES, THREE D.H.R. EMPLOYEES, AND THREE EMPLOYEES FROM I.S.D. THE TEAM UTILIZED THEIR STRENGTH TO DEVELOP A COMPREHENSIVE PLAN FOR RECRUITMENT AND OUTREACH, AN UPDATED WEBSITE, AN APPLICATION PROCEDURE THAT WAS NOT LIMITED BY GEOGRAPHY, AND AN EXAMINATION PROCESS THAT REDUCED COSTS BY TWO-THIRDS OF THE COSTS FROM BEFORE. BY NOT DOING BUSINESS AS USUAL, THE TEAM WAS ABLE TO APPLY NEW CONCEPTS AND TECHNIQUES TO DEVELOP SOLUTIONS AND IDEAS THAT SAVED MONEY WHILE IMPROVING SERVICES TO THE CONSTITUENTS OF LOS ANGELES COUNTY. THE TEAM INCLUDES CARLA D. WILLIAMS, ANISE AWAD, DEBORAH THOMAS, SUSAN CAMBREN, NICK APALLAS, MARK SHUNTZER, JEFF CAIN, DANA LOO, SAMUEL KUMALAFE, DANNY CHU, ANDERSON MACKIE, AND ARSON MERCKE-YOUNG. CONGRATULATIONS. [ APPLAUSE ] 

SUP. BURKE, CHAIR: THANK YOU SO MUCH. CONGRATULATIONS. [ APPLAUSE ] 

SUP. BURKE, CHAIR: WE'LL NOW GO TO THE FIRST DISTRICT. 

SUP. KNABE: MADAM CHAIR, MEMBERS OF THE BOARD, AS WE ALL KNOW, EACH YEAR SINCE 1982, THE MUSIC CENTER BRAVO AWARD HAS BEEN PRESENTED TO RECOGNIZE TEACHERS AND SCHOOLS FOR THEIR INNOVATION AND EXCELLENCE IN ARTS EDUCATION. THE BRAVO AWARD HONORS EDUCATORS WHO USE THE ARTS TO REVITALIZE TEACHING, ENHANCE STUDENT ACHIEVEMENT, AND FOSTER SELF-ESTEEM, TEAMWORK AND CROSS-CULTURAL COMMUNICATION AND UNDERSTANDING. BRAVO AWARD NOMINEES ARE EITHER SELF-IDENTIFIED OR IDENTIFIED BY OTHER EDUCATORS. THEY MUST BE FULL-TIME TEACHERS OR ADMINISTRATORS IN PUBLIC, PRIVATE, OR CHARTER SCHOOLS. THIS YEAR, THERE WERE THREE FINALISTS IN EACH OF THE FOLLOWING THREE CATEGORIES. GENERAL EDUCATION TEACHERS, ART SPECIALIST TEACHERS IN SCHOOLS, AND IN ADDITION TO THE FINALISTS, WE ALSO HAVE WITH US TODAY A FEW OF THE HONORABLE MENTION AWARDEES. EACH SUPERVISOR WILL BE PRESENTING THE AWARDEES IN THEIR PARTICULAR DISTRICTS AND I'M GOING TO BEGIN WITH MY DISTRICT. FIRST OF ALL, JANET BARKER WAS ONE OF THE THREE GENERALIST TEACHER FINALISTS. JANET TEACHES LANGUAGE ARTS AT PARIS MIDDLE SCHOOL IN REDONDO BEACH, WHICH IS PART OF THE REDONDO UNIFIED SCHOOL DISTRICT, AND MASTERFULLY INTEGRATES THE ARTS INTO HER EIGHTH GRADE CLASSES. SHE IS JOINED TODAY BY HER PRINCIPAL, SALLY TEHEJAN. ALL RIGHT. CONGRATULATIONS. [ APPLAUSE ] 

SUP. KNABE: NEXT IS JONATHAN CHIANG. HE IS AN ART SPECIALIST HONORABLE MENTION. HE WAS UNABLE TO JOIN US TODAY. HE IS THE BAND DIRECTOR AT GLEN WILSON HIGH SCHOOL, WHERE HE IS A VERY INSPIRING AND OUTSTANDING EDUCATOR WHO IS REPRESENTED TODAY BY ASSISTANT PRINCIPAL JAMIE MILAN AND THE PRESIDENT OF THE HACIENDA SCHOOL BOARD, A GOOD FRIEND, NORMAN SUE. CONGRATULATIONS TO JONATHAN. MY BROTHER WAS A MEMBER OF THE WILSON HIGH SCHOOL BAND YEARS AGO. [ APPLAUSE ] 

SUP. KNABE: OKAY. SUPERVISOR MOLINA. 

SUP. MOLINA: THANK YOU, SUPERVISOR KNABE. YOU KNOW, THE ARTS PLAY A VERY SIGNIFICANT ROLE IN ALL OF OUR COMMUNITY, AND I'M PARTICULARLY PROUD OF THE BRAVO AWARDS AND THE WINNERS IN MY DISTRICT. I KNOW THAT FOR MYSELF, I REMEMBER AS LITTLE AS A KINDERGARTENER WHO HAD A TEACHER WHO LOVED THE STRAUSS WALTZES AND SHARED WITH ALL OF US, AND I CAN REMEMBER THAT FONDLY. AND ALSO HAVING AN ARTS TEACHER IN THE EIGHTH GRADE BY THE NAME OF MS. TOLSTER, WHO TAUGHT US ABOUT THE OPERA AND ALL THOSE FINE ARTS AND ALL. AND I'M VERY PROUD OF THE WINNERS TODAY. IN MY DISTRICT, WE HAVE TWO IMPORTANT PRESENTATIONS. FIRST OF ALL, BARBARA ANN HINCKLEY, WHO RECEIVED HONORABLE MENTION AT THE BRAVO AWARDS. SHE TEACHES AT VAN WIG ELEMENTARY SCHOOL WITHIN THE BASSETT SCHOOL DISTRICT. I WANT TO CONGRATULATE HER. AND SHE'S JOINED TODAY BY HER ASSISTANT SUPERINTENDENT OF BASSETT SCHOOL DISTRICT, SHERYL BEAN. CONGRATULATIONS TO BOTH OF YOU. [ APPLAUSE ] 

SUP. MOLINA: NEXT WE HAVE THE GENERAL EDUCATION TEACHER THAT WON THE BRAVO AWARD. SHE TEACHES AT MOUNT WASHINGTON ELEMENTARY SCHOOL AT L.A. UNIFIED. I WANT TO EXTEND HER OUR DEEPEST CONGRATULATIONS. THAT'S THE DAUGHTER THAT ATTENDED MOUNT WASHINGTON. CONGRATULATIONS. AND THAT IS SOPHINY CONVAY. THANK YOU AND CONGRATULATIONS TO YOU. [ APPLAUSE ] 

SUP. KNABE: SUPERVISOR BURKE, YOU'RE NEXT. COULD I JUST MAKE ONE INTRODUCTION? I'D LIKE TO WELCOME, FROM MILLIGAN HIGH SCHOOL IN LONG BEACH, WE HAVE TEACHERS MRS. VAN DYNE AND MR. UNDERWOOD AND STUDENTS FROM MILLIGAN MULTI-CULTURAL LITERATURE CLASS AND CAMPUS DIVERSITY CLUB, ONE LOVE, WHO ARE SITTING IN THE AUDIENCE. WE SPENT SOME TIME TOGETHER EARLY THIS MORNING. I'D LIKE THEM TO STAND UP. AND WE HOPE YOU ENJOY THE MEETING AND HAVE A GREAT DAY DOWN HERE. [ APPLAUSE ] 

SUP. KNABE: GO RAMS! [ CHEERS ] 

SUP. BURKE, CHAIR: MOFFITT ELEMENTARY SCHOOL RECEIVED HONORABLE MENTION. JOINING US TODAY IS JOANNE ESKIN, PRINCIPAL OF MOFFITT ELEMENTARY SCHOOL. IT'S AN L.A.U.S.D. SCHOOL. MS. ESKIN IS A DEDICATED LEADER WHO BELIEVES ALL CHILDREN DESERVE THE BEST ARTS EDUCATION POSSIBLE AND IS TIRELESS IN HER EFFORTS TO MAKE MOFFITT A STANDOUT PROGRAM AMONG ITS PEERS. THE SUPERINTENDENT OF LENNOX SCHOOL DISTRICT, BRUCE MCDANIELS, IS ALSO HERE WITH MRS. ESKIN. AND THEY HAVE A WONDERFUL, WONDERFUL SCHOOL THERE UNDER DIFFICULT CONDITIONS. BUT THEY'VE JUST EXCELLED. THEY TAKE STUDENTS WHO REALLY NEED THE ASSISTANCE AND THEN THEY EXCEL ABOVE ALL OTHERS, SO CONGRATULATIONS TO YOU. [ APPLAUSE ] 

SUP. BURKE, CHAIR: SUPERVISOR YAROSLAVSKY. I CAN NEVER SAY ENOUGH ABOUT THE LENNOX SCHOOL DISTRICT. IT'S ALWAYS AN EXCELLENT SCHOOL DISTRICT. 

SUP. YAROSLAVSKY: THANK YOU, MADAM CHAIR. IT'S MY PRIVILEGE TO INTRODUCE THE HONOREES FROM OUR DISTRICT. FIRST OF ALL, COLFAX AVENUE ELEMENTARY SCHOOL -- OH, SORRY. COLFAX AVENUE ELEMENTARY SCHOOL WAS A FINALIST, AND IS LED BY THE DYNAMIC JOANIE FRECKMAN. THE PASSION FOR ARTS IS EVIDENT THE MOMENT YOU WALK ONTO THE CAMPUS OF COLFAX, WHICH IS OF COURSE PART OF THE L.A. UNIFIED SCHOOL DISTRICT. COLFAX AVENUE ELEMENTARY SCHOOL PROVIDES A RICH PROGRAM FOR GRADES KINDERGARTEN THROUGH 5 IN ALL FOUR ARTS DISCIPLINES, VISUAL ARTS, THEATRE ARTS, DANCE, AND MUSIC. IS TOM WALDEN HERE? THERE HE IS. HEY, TOM. WHO IS CHIEF OF STAFF TO SCHOOL BOARD MEMBER, TAMAR GALETSON. AND HE IS JOANIE'S GUEST HERE TODAY AND WE'RE HONORED TO PRESENT YOU WITH THIS CERTIFICATE. CONGRATULATIONS AND KEEP UP THE GREAT WORK. [ APPLAUSE ] 

SUP. YAROSLAVSKY: NEXT, ANGELA GOTSHALL, WAS ONE OF THE THREE ART SPECIALIST TEACHERS FINALISTS. ANGELA TEACHES THEATRE AT GEORGE E. HALE MIDDLE SCHOOL, ALSO PART OF THE L.A. UNIFIED SCHOOL DISTRICT. HER ENTHUSIASM AND COMMITMENT TO THE ARTS AND TO ARTS EDUCATION IS RECOGNIZE THROUGHOUT HER DISTRICT BY HER PEERS AND ADMINISTRATORS. MS. GOTSHALL'S GUEST HERE WITH HER IS NEIL SEGEL, WHO IS PRINCIPAL OF GEORGE HALE MIDDLE SCHOOL. CONGRATULATIONS TO ANGELA. AND LASTLY, SHE'S NOT HERE, BUT I DID WANT TO ACKNOWLEDGE JOANIE SWINSON, WHO IS ONE OF THE THREE ART SPECIALISTS TEACHER FINALISTS FROM SANTA MONICA HIGH SCHOOL, WHICH OF COURSE IS PART OF THE SANTA MONICA SCHOOL DISTRICT. HER ORCHESTRA TOURS PLAYED TO WORLD WIDE CRITICAL ACCLAIM. BECAUSE OF HER BUSY CONCERT SCHEDULE, JOANIE SWENSON IS NOT ABLE TO JOIN US, BUT WE'LL PRESENT THE CERTIFICATE TO HER TOO. THANK YOU VERY MUCH, MADAM CHAIR. 

SUP. BURKE, CHAIR: THANK YOU. SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: ROBIN TODER IS THE PRINCIPAL OF GERMAIN ELEMENTARY SCHOOL. SHE'S USED HER LEADERSHIP AND VISION FOR AN ARTS PROGRAM TO GARNER AN HONORABLE MENTION FOR HER SCHOOL. AND THIS YEAR, TOM WALDEN IS HER GUEST. I HAD THE OPPORTUNITY OF ATTENDING THE BRAVO DINNER THIS YEAR. AND ONCE AGAIN, GARRY MARSHALL DID A SUPERB JOB AS THE MASTER OF CEREMONIES AS HE DOES EACH YEAR WHEN HE TAKES TIME OUT OF HIS CAREER OF FILING AND PRODUCING THE VARIOUS MOTION PICTURES TO BE WITH THE STUDENTS, BECAUSE HE HAS SUCH A GREAT DEDICATION AND COMMITMENT TO OUR YOUTH IN OUR COUNTY OF LOS ANGELES AND SOUTHERN CALIFORNIA. SO ON BEHALF OF THE COUNTY, LET US GIVE YOU THIS CERTIFICATE OF RECOGNITION. [ APPLAUSE ] 

SUP. ANTONOVICH: PAUL SEVESEN TEACHES CHORAL MUSIC AT WESTRIDGE, WHICH IS A PRIVATE GIRLS SCHOOL IN PASADENA. AND AS THE CHORAL DIRECTOR FOR THE UPPER SCHOOL, HE WAS HONORED THIS YEAR AS A BRAVO FINALIST. HIS COMMITMENT TO CULTURAL UNDERSTANDING IS EVIDENT IN THE WIDE VARIETY OF MUSICAL SELECTIONS WHICH INSPIRES HIS STUDENTS TO LEARN ABOUT THE WORLD OUTSIDE OF THEIR IMMEDIATE SURROUNDINGS. AND HE'S ACCOMPANIED BY THE PERFORMING ARTS COORDINATOR FOR WESTRIDGE SCHOOL, PAUL JANAPAPOLIS. OKAY. LET'S HEAR IT FOR THE GREEKS. 

SPEAKER: THANK YOU. [ APPLAUSE ] 

SUP. ANTONOVICH: CHARLOTTE SMITHWAITE TEACHES CHORAL MUSIC FOR GLENDALE UNIFIED SCHOOL DISTRICT AT WOODROW WILSON MIDDLE SCHOOL. AND HER PASSION FOR SINGING AND FOR TEACHING WON HER AN HONORABLE MENTION THIS YEAR AT THE BRAVO AWARDS. SO CONGRATULATIONS. WHO IS WITH YOU? WE'VE GOT OUR SCHOOL BOARD MEMBER. MRS. JENKS IS A DYNAMIC FIRST GRADE TEACHER AT VALLEY VIEW ELEMENTARY SCHOOL IN GLENDALE UNIFIED SCHOOL DISTRICT. SHE USED MUSIC, DANCE, AND DRAMA ENHANCE HER TEACHING. SHE WAS AWARDED THE DIGITAL VOICE AWARD FROM THE L.A. COUNTY RECOGNITION FOR OUTSTANDING LESSON PLAN, FOR TECHNOLOGICAL INSTRUCTION. LISA WAS A FINALIST IN THIS YEAR'S GENERALIST CATEGORY. JOLENE WAGNER, PRESIDENT OF OUR SCHOOL BOARD, DR. ESCALANTE, THE SUPERINTENDENT OF SCHOOLS, AND ALICE PETROZIAN, ASSISTANT SUPERINTENDENT, AND DR. JOAN TROFF, VISUAL AND PERFORMING ARTS COORDINATOR, ARE ALL HERE, AS THEY WERE JUST WITH THE PREVIOUS RECIPIENT FROM THE UNIFIED SCHOOL DISTRICT AS HER GUESTS, SO CONGRATULATIONS. [ APPLAUSE ] 

SUP. ANTONOVICH: YOU BROUGHT THE BIG GUNS TOO. 

SUP. BURKE, CHAIR: I THINK -- DO YOU HAVE ONE MORE? 

SUP. KNABE: THE MUSIC CENTER EDUCATION DIVISION VICE PRESIDENT, MARKS LAPKIN WAS GOING TO JOIN US TODAY BUT HE IS ILL. BUT JOINING US TODAY IS THE BRAVO PROGRAM MANAGER, FAITH DAVIS. 

SUP. BURKE, CHAIR: HE HAS ONE MORE. 

SUP. KNABE: I'M SORRY. THAT'S WHY I ASKED THE QUESTION. OKAY. GO AHEAD. 

SUP. ANTONOVICH: THE LAST ONE IS FROM SYCAMORE ELEMENTARY SCHOOL IN CLAREMONT. AND THIS IS LED BY PRINCIPAL THOMAS COOPER, WHO IS NOT HERE WITH US TODAY. SYCAMORE WAS A SCHOOL FINALIST FOR THIS YEAR'S PRESENTATION, SO WE WISH CLAREMONT CONTINUED SUCCESS AND WE'LL TURN IT OVER TO SUPERVISOR DON KNABE. 

SUP. KNABE: THANK YOU, MICHAEL. AGAIN, HOW ABOUT THIS, I'M GOING TO ASK OUR BRAVO PROGRAM MANAGER, FAITH DAVIS, TO SHARE A FEW WORDS WITH US. FAITH? 

FAITH DAVIS: THANK YOU, SUPERVISORS ON BEHALF OF THE MUSIC CENTER FOR HONORING THIS YEAR'S BRAVO NOMINEES. I BROUGHT BRAVO PINS FOR ALL OF THE SUPERVISORS. I'LL GIVE THEM TO GAYLE AND SHE CAN PASS THEM OUT. THANK YOU AGAIN. [ APPLAUSE ] 

SUP. KNABE: THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. I'D LIKE TO CALL FORWARD DR. JONATHAN FIELDING, DIRECTOR OF PUBLIC HEALTH, DOCTOR MICHELLE PARRA, DIRECTOR OF D.P.H. IMMUNIZATION PROGRAM AND JULIA HEINZERLING, WHO IS D.P.H. POLICY AND ADVOCACY SPECIALIST. IMMUNIZATIONS ARE SAFE, EFFECTIVE, AND THE BEST WAY TO PROTECT INFANTS AND YOUNG CHILDREN, THEIR FAMILIES AND COMMUNITIES AGAINST SERIOUS AND SOMETIMES DEADLY VACCINE-PREVENTABLE DISEASES. INFANTS AND YOUNG CHILDREN STILL SUFFER FROM DISEASES SUCH AS PERTUSSIS AND CHICKEN POX AND MEASLES. ALL OF THESE DISEASES ARE PREVENTABLE BY CHILDHOOD IMMUNIZATION. ONE OUT OF THE FIVE CHILDREN IN LOS ANGELES HAVE NOT RECEIVED ALL THEIR RECOMMENDED IMMUNIZATIONS BY THE TIME THEY ARE 24 MONTHS, LEAVING THEM AT RISK FOR ILLNESS. FREE AND LOW COST IMMUNIZATIONS ARE AVAILABLE FOR INFANTS AND YOUNG CHILDREN THROUGHOUT L.A. COUNTY. A COALITION OF CONCERNED PUBLIC HEALTH COMMUNITY AND BUSINESS ORGANIZATIONS HAVE JOINED TOGETHER TO OBSERVE NATIONAL INFANT IMMUNIZATION WEEK AND TODDLER IMMUNIZATION MONTH TO INCREASE AWARENESS AND IMPORTANCE OF IMMUNIZATION. IT IS WITH GREAT PLEASURE THAT I PRESENT THIS SCROLL TO DR. JONATHAN FIELDING, DR. MICHELLE T. PARRA AND JULIA HEINZERLING AS WE PROCLAIM APRIL 16TH THROUGH THE 19TH, 2008, AS NATIONAL INFANT IMMUNIZATION WEEK AND THE MONTH OF MAY AS NATIONAL TODDLER IMMUNIZATION WEEK THROUGHOUT LOS ANGELES COUNTY. [ APPLAUSE ] 

DR. JONATHAN FIELDING: IMMUNIZATIONS ARE SO MUCH A PART OF THE PRACTICE OF MEDICINE THAT WE SOMEHOW FORGET HOW IMPORTANT THEY ARE. AND LET ME JUST GIVE ONE EXAMPLE. WE'VE HAD TWO CASES OF MEASLES IN LOS ANGELES COUNTY AND THAT'S A VERY SERIOUS PROBLEM THAT IS JUST STARTING TO REEMERGE. AND LOOKING AT MEASLES, IT WAS IN 1963 THAT THE MEASLES VACCINE WAS DEVELOPED. MOST PARENTS OF YOUNG CHILDREN TODAY HAVE NEVER SEEN MEASLES, AND THEY MAY NOT BE AWARE THAT MEASLES CAN BE A VERY SERIOUS DISEASE. FOR EXAMPLE, ONE IN 20 CHILDREN WITH MEASLES WILL GET PNEUMONIA FROM IT. AND ONE IN A THOUSAND OR TWO IN A THOUSAND WILL WIND UP WITH, UNFORTUNATELY, ENCEPHALITIS. AND YOU CAN HAVE BETWEEN ONE AND THREE DEATHS PER THOUSAND CHILDREN. SO THESE DISEASES, LIKE MEASLES, LIKE WHOOPING COUGH, WHICH IS COMING BACK, ARE VERY SERIOUS. AND I HOPE THAT ALL PARENTS WILL MAKE SURE NOT ONLY THAT THEIR CHILDREN ARE IMMUNIZED, BUT THEY'RE IMMUNIZED ON TIME. BECAUSE WE'VE HAD A LOT OF CASES WITH CHILDREN HAVING DISEASES THAT COULD HAVE BEEN PREVENTED AND PARENTS SAYING, "OH YEAH, I JUST MISSED A FEW" OR "I FORGOT," OR WHATEVER. SO THIS IS A GREAT TIME TO REDEDICATE OURSELVES TO MAKING SURE EVERY CHILD STARTS OFF GETTING PROTECTED AGAINST MANY VACCINE-PREVENTABLE DISEASES THAT WERE TERRIBLE SCOURGES NOT MORE THAN 50 YEARS AGO AND TODAY ARE, FORTUNATELY, NOT KNOWN. BUT WE WANT TO MAKE SURE IN THE FUTURE THAT THEY'RE NOT KNOWN THEN EITHER. THANK YOU VERY MUCH, SUPERVISOR AND BOARD. 

SUP. BURKE, CHAIR: NOW I'D LIKE TO CALL UP W.L.C.A.C. REPRESENTATIVE PROGRAM DIRECTOR JAMES SMITH. WATTS LABOR COMMUNITY ACTION COMMITTEE IS A NONPROFIT COMMUNITY-BASED ORGANIZATION FOUNDED IN 1965 TO IMPROVE THE QUALITY OF LIFE FOR RESIDENTS IN SOUTH LOS ANGELES. W.L.C.A.C. HAS BUILT MORE THAN 3,000 UNITS OF AFFORDABLE HOUSING AND SUCCESSFULLY PROMOTES HOME OWNERSHIP IN IMPOVERISHED NEIGHBORHOODS. THEY ARE ALSO PROUD OPERATIONS OF NATIONALLY AFFILIATED YOUTH-BUILD PROGRAM. THE PROGRAM WAS ESTABLISHED IN 2003 AND PRESENTLY HAS 40 PARTICIPANTS ENROLLED ON A FULL-TIME BASIS FOR UP TO 9 THROUGH 15 MONTHS. STUDENTS CURRENTLY ARE HELPING IN THE PRODUCTION OF 49 UNITS OF HOUSING IN SOUTH LOS ANGELES FOR LOW INCOME HOME BUYERS IN PARTICIPATION WITH A.M.C.A.L. GENERAL CONTRACTORS. YOUTHBUILD ALLOWS AT-RISK YOUTH THE OPPORTUNITY TO CHANGE THEIR LIVES BY ENGAGING IN ONGOING INSTRUCTION FOR CERTIFICATION IN CONSTRUCTION, PARTICIPATION IN LEADERSHIP DEVELOPMENT ACTIVITIES, PURSUING ONGOING EDUCATION AND OBTAINING MANY OF THE PRIVILEGES YOUTH TAKE FOR GRANTED, SUCH AS A VALID DRIVER'S LICENSE. THIS SUCCESSFUL PROGRAM IS OFFERED THROUGH AN EDUCATIONAL PARTNERSHIP WITH MAXINE WATERS EMPLOYMENT PREPARATION CENTER. MORE THAN 70% OF THE PROGRAM PARTICIPANTS ARE ESTIMATED TO COMPLETE THE PROGRAM BY JANUARY 2009. 23% WILL ENROLL IN COMMUNITY COLLEGES AND 40% WILL ENTER THE CONSTRUCTION INDUSTRY. IT'S WITH GREAT PLEASURE THAT I PRESENT THIS SCROLL TO THE WATTS LABOR COMMUNITY ACTION COMMITTEE AS WE CELEBRATE THIS SPECIAL OCCASION OF ITS SUCCESSFUL W.L.C.A.C. YOUTHBUILD PROGRAM AND GRADUATION OF ITS FIRST 39 YOUTH LEADERS. [ APPLAUSE ] 

SUP. BURKE, CHAIR: AND I'D LIKE TO MAKE THIS PRESENTATION... EDWARD CURRY. DONOVAN SNOW. DARSHE HERD. IRIS MIRANDA. CONGRATULATIONS TO YOU. THANK YOU. THANK YOU VERY MUCH. AND YOUR NAME IS? 

SPEAKER: (OFF-MIKE). 

SUP. BURKE, CHAIR: GERRELL SWAIN IS PRESENTING US WITH A TEE SHIRT. THANK YOU. 

JAMES SMITH: THANK YOU. THANK YOU, SUPERVISOR BURKE AND THE BOARD OF SUPERVISORS. MY NAME IS JAMES SMITH AND I'M THE DIRECTOR FOR THE W.L.C.A.C. YOUTHBUILD PROGRAM. MYSELF AND MR. RAYMOND WASHINGTON, OUR LEADERSHIP COORDINATOR, ARE HERE WITH SOME OF OUR REPRESENTATIVES OF THE YOUTHBUILD YOUNG LEADERS WHO ARE GRADUATING THIS FRIDAY. THEY REPRESENT 39 YOUNG PEOPLE THAT HAVE HAD HANDS-ON IN BUILDING LOW INCOME HOUSING, THEY HAVE HAD HANDS-ON IN MAKING SURE THAT THEY DROP BACK INTO EDUCATION TO RECEIVE THEIR HIGH SCHOOL DIPLOMA AND G.E.D. THEY HAVE NOT HAD TIME FOR GANGS, DRUGS, AND DOING NOTHING IN THE COMMUNITY. THEY HAVE HAD ALL THE LEADERSHIP DIRECTION THAT YOUTHBUILD COULD GIVE THEM. YOUTHBUILD HAS BEEN AROUND FOR 20-SOME YEARS HERE OPERATING IN THIS GREAT COUNTY. AND WE WANT YOUTHBUILD TO CONTINUE TO BE THERE FOR YOUNG PEOPLE THAT ARE LOOKING FOR AN OPPORTUNITY AND A SECOND CHANCE. WE WANT TO THANK SUPERVISOR BURKE FOR CONTINUED BRINGING US THROUGH THE DOOR OF THE HALLS OF THE ADMINISTRATION SO THAT SHE COULD SEE THE YOUNG PEOPLE AND KNOW THAT THEY ARE THE NEW WORK FORCE IN THIS COUNTY. WE THANK HER FOR ALL OF HER LEADERSHIP AND WISH HER GOD SPEED. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. SUPERVISOR MOLINA? SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: MADAM CHAIR, THANK YOU. I'D LIKE TO ASK -- MICHAEL JUDGE, THERE YOU ARE -- TO JOIN ME FOR A VERY SPECIAL PRESENTATION. MICHAEL JUDGE CURRENTLY SERVES WITH DISTINCTION AS THE CHIEF PUBLIC DEFENDER FOR THE COUNTY OF LOS ANGELES, A POSITION THAT CARRIES RESPONSIBILITY FOR SUPERVISING AND MANAGING THE OPERATION OF 40 OFFICES FOR A DEPARTMENT COMPRISING MORE THAN 700 LAWYERS. MICHAEL IS A FORMER TRUSTEE OF THE LOS ANGELES COUNTY BAR ASSOCIATION AND A MEMBER OF THE LOS ANGELES SUPERIOR COURT BENCH BAR COALITION, IS AN EXECUTIVE BOARD MEMBER OF THE CRIMINAL COURTS BAR ASSOCIATION AND HAS BEEN A MEMBER OF THE LOS ANGELES COUNTY BAR ASSOCIATION GOVERNMENT LAWYER MEMBERSHIP TASK FORCE. MICHAEL JUDGE HAS SERVED ON THE EXECUTIVE BOARD OF THE NATIONAL ASSOCIATION OF DRUG COURT PROFESSIONALS AND IS A VICE-CHAIRPERSON OF THE LOS ANGELES DRUG COURT OVERSIGHT COMMITTEE, LOBBIED SUCCESSFULLY TO INCLUDE DRUG COURT PROVISIONS IN CALIFORNIA'S DIVERSION STATUTE, TRAVELED WIDELY, SPOKEN FREQUENTLY, AND PUBLISHED PROLIFICALLY ON THE SUBJECT OF DRUG TREATMENT AND DIVERSION PROGRAMS IN THE JUSTICE SYSTEM. MICHAEL HAS BEEN RECOGNIZED FOR HIS LEGAL WORK WITH SUCH HONORS AS THE LAUREN MILLER AWARD, THE JOHN M. LANGSTON BAR LAWYER OF THE YEAR, THE NATIONAL LEADERSHIP AWARD OF THE N.A.D.C.P., THE DRUG CORPS PROGRAM, THE JUSTICE CRUZ RENOSO AWARD FOR PRINCIPLED LEADERSHIP FROM THE MEXICAN-AMERICAN BAR ASSOCIATION, A LOS ANGELES COUNTY BAR CRIMINAL JUSTICE LIFETIME ACHIEVEMENT AWARD, REPEATED CITATIONS AS ONE OF CALIFORNIA'S MOST INFLUENTIAL LAWYERS, AND MANY OTHERS FAR TOO NUMEROUS TO MENTION, AND HE'S ONLY 27 YEARS OLD. MICHAEL WAS MOST RECENTLY AWARDED THE 2007 CLAY AWARD FROM THE CALIFORNIA LAWYER MAGAZINE FOR FIGHTING SUCCESSFULLY TO HELP ENACT FEDERAL LEGISLATION DESIGNED TO FACILITATE YOUNG LAWYERS ENTERING PUBLIC SECTOR LEGAL SERVICE. I HAD A PASSING INTEREST IN THAT LEGISLATION, BECAUSE OF SOMEBODY IN MY FAMILY WHO COULD HAVE USED THIS AT THE RIGHT TIME, WHO JUST FINISHED LAW SCHOOL. BUT HE WAS A YEAR TOO EARLY. AND I KNOW WE WORKED TOGETHER ON TRYING TO GET THAT LEGISLATION PASSED. SO, WE WANTED TO TAKE THIS OPPORTUNITY, MICHAEL, TO HONOR YOU FOR THE CLAY AWARD. THE BOARD OF SUPERVISORS OF LOS ANGELES COUNTY WANTS TO HEREBY COMMEND MICHAEL P. JUDGE FOR HIS MANY PROFESSIONAL ACCOMPLISHMENTS AND BE EXTENDED SINCERE CONGRATULATIONS AS ONE OF CALIFORNIA LAWYER MAGAZINE'S 2007 ATTORNEYS OF THE YEAR WITH BEST WISHES FOR CONTINUED SUCCESS AND FULFILLMENT IN ALL HIS ONGOING ENDEAVORS. I THINK WE ALL KNOW MICHAEL VERY WELL, WE DON'T NEED TO GIVE A BIG SPEECH ABOUT YOU, BUT I JUST DID. BUT THE DEPARTMENTS THAT OPERATE BEST ARE THE ONES WE NEVER HEAR ABOUT, AND WE DON'T HEAR A LOT OF PROBLEMS OUT OF THE PUBLIC DEFENDER'S OFFICE. IN FACT, I CAN'T RECALL THE LAST TIME WE HAD A PROBLEM IN THE PUBLIC DEFENDER'S OFFICE, WHICH IS REMARKABLE BECAUSE IT'S A HIGHLY SENSITIVE AND DELICATE BUSINESS THAT YOU'RE IN. BUT YOU HAVE CARRIED ON THAT RESPONSIBILITY WITH GREAT SKILL AND PASSION AND YOU'RE ALWAYS THINKING ONE STEP AHEAD HOW YOU CAN IMPROVE THE QUALITY OF THE OFFICE AND NOT ONLY THIS OFFICE IN OUR COUNTY AND THE STATE AND BEYOND. YOUR COMMITMENT TO THE JUSTICE SYSTEM IS INCREDIBLE, AND I'M HONORED TO PRESENT THIS TO YOU MICHAEL, CONGRATULATIONS. [ APPLAUSE ] 

SUP. ANTONOVICH: LET ME JUST ADD THAT AS SUPERVISOR AND AS FORMER CHAIRMAN ABOUT FIVE, SIX TIMES OF THE COUNTY-WIDE CRIMINAL JUSTICE COMMITTEE, MICHAEL HAS BEEN A VERY CONSTRUCTIVE VOICE WORKING WITH PROSECUTORS, OUR FEDERAL AND STATE AND LOCAL OFFICIALS. AND ONE OF THE PROGRAMS THAT WON OUR NATIONAL AWARD THAT WAS HEADED BY JUDGE -- DEALT WITH THE COMPUTERIZATION OF THE COURTS. AND MICHAEL WAS A PART OF THAT COMMITTEE. AND WE REALLY APPRECIATE HIS LEADERSHIP, HIS DEDICATION. BUT HIS TRUE DEDICATION IS NOT FROM HIM, IT'S FROM HIS WIFE, DEEDEE, WHO PUSHES HIM TO DO THESE GREAT ACHIEVEMENTS. RIGHT? 

MICHAEL JUDGE: I SHOULD HAVE BROUGHT HER. I DIDN'T KNOW YOU GUYS WERE GOING TO DO THIS. 

SUP. ANTONOVICH: YOU SHOULD HAVE BROUGHT HER. 

MICHAEL JUDGE: WELL, I'M REALLY DELIGHTED THAT WE WERE ABLE TO ACCOMPLISH WHAT PROMPTED THE CALIFORNIA LAWYER OF THE YEAR AWARD WHICH WAS TO, WITH THE BOARD'S HELP, SECURE STUDENT LOAN FORGIVENESS FOR PUBLIC EMPLOYEES, INCLUDING PUBLIC DEFENDERS AND PROSECUTORS. BECAUSE OF THE BOARD'S APPROVAL OF THIS AS PART OF THE FEDERAL AGENDA, WE HAD THE SERVICES OF THE LOBBYISTS IN D.C., AND GREG CAMPBELL IN PARTICULAR. WE ALSO HAD MARK DEGIMA FROM THE C.E.O.'S OFFICE HERE TO ADVISE US. I WAS FORTUNATE ENOUGH TO LEAD A NATIONAL COALITION OF PEOPLE FROM BOTH PROSECUTING OFFICES AND DEFENDER OFFICES AND SEVERAL MEMBERS OF THE BOARD HERE CONTACTED INDIVIDUALS. I KNOW MIKE ANTONOVICH, YOU DID, AND ZEV, YOU DID AS WELL WHEN WE WERE HAVING SOME DIFFICULTY TRYING TO GET MEETINGS. STEVE COOLEY CAME IN AND ASSISTED WITH CERTAIN KEY PEOPLE. SO IT WAS REALLY A COLLABORATION AND A VERY IMPORTANT ONE FOR THE FUTURE OF BOTH THE PROSECUTING AND DEFENDER OFFICES IN THIS COUNTY. AND I WANT TO THANK YOU VERY MUCH FOR THE MOST GENEROUS REMARKS I'VE EVER HEARD IN MY LIFE. THANK YOU. [ APPLAUSE ] 

SUP. YAROSLAVSKY: MADAM CHAIR, I WANT TO JUST PUNCTUATE THE POINT, THE EFFORT THAT HE HAS SUCCEEDED IN ACHIEVING ALLOWS -- THERE ARE SO MANY PEOPLE, BECAUSE MY SON JUST FINISHED LAW SCHOOL, AS YOU ALL KNOW, WHO INCUR INCREDIBLE DEBT TO GO TO LAW SCHOOL, BUT DON'T WANT TO BECOME RICH, THEY WANT TO GET INTO THE PUBLIC SECTOR, BUT THEY CAN'T AFFORD TO DO IT. THIS BILL WILL ENABLE PEOPLE TO REALIZE THE DREAM FOR WHICH THEY WENT TO LAW SCHOOL IN THE FIRST PLACE AND NOT BE SADDLED WITH LIFETIME DEBT AND WE GET THE INCREDIBLE QUALITY OF PERSONNEL THAT WAY WHO ARE IN THIS FOR THE RIGHT REASONS. AND I JUST, AGAIN, THANK YOU FOR THAT, NOT ONLY ON BEHALF OF ALL THE LAW STUDENTS OUT THERE, BUT, REALLY, WE'RE GOING TO GET A BETTER QUALITY OF EMPLOYEE AS A RESULT AND THE PUBLIC IS BETTER SERVED AS A RESULT, SO THANKS, MICHAEL. 

MICHAEL JUDGE: THANK YOU VERY MUCH. 

SUP. KNABE: I THINK SUPERVISOR ANTONOVICH WAS GOING TO DO ONE BEFORE I DID MINE. I'M LOOKING FOR DIRECTION. CORRECT? 

SUP. ANTONOVICH: THIS IS A PROGRAM THAT WE ARE SO PLEASED THAT IS HAVING MUCH SUCCESS AND THAT'S OUR ADOPTION PROGRAM. FOSTER CARE AWARENESS MONTH IS GOING TO BE THE MONTH OF MAY. AND THIS IS WHERE WE ARE LOOKING FOR PERMANENT MOMENTS FOR OUR CHILDREN IN FOSTER CARE. DURING THIS MONTH, WE WILL RECOGNIZE THE ADOPTIVE AND FOSTER FAMILIES WHO HAVE SHARED THEIR HOMES AND HEARTS WITH CHILDREN IN NEED. AND WE ENCOURAGE MORE OF OUR COUNTY RESIDENTS TO CONSIDER ADOPTING YOUNG PEOPLE. WITH US IS TRISH PLOEHN, WHO IS OUR DIRECTOR, YVONNE CREZISHANI, AND STEPHANIE CLANCY, VICE PRESIDENT OF THE HEART GALLERY. FAMILIES WHO ADOPT CHILDREN PROVIDE A GENEROUS OPPORTUNITY FOR THESE YOUNG PEOPLE TO HAVE A FUTURE AND TO BECOME THE PRODUCTIVE CITIZENS THAT OUR COUNTRY NEEDS. THERE ARE OVER 8,000 CHILDREN LIVING IN FOSTER HOMES OR GROUP HOMES IN OUR COUNTY TODAY WHO, FOR ONE REASON OR ANOTHER, HAVE NO PARENTS OR NO HOMES. NEARLY 600 OF THESE CHILDREN ARE CURRENTLY AWAITING ADOPTIONS, AND BEHIND ME IS A PHOTO DISPLAY OF PHOTOGRAPHS OF CHILDREN IN FOSTER CARE WHO ARE SEEKING MOTHERS AND FATHERS TO BE THAT PARENT. AND WE WOULD LIKE TO ENSURE THAT THESE PEOPLE, MOST OF THEM ARE BETWEEN THE AGES OF 5 AND 15, ALTHOUGH SOME ARE A LITTLE OLDER, SOME A LITTLE YOUNGER, ARE LOOKING FOR THE PEOPLE TO PROVIDE THEIR HOME. WE HAVE ENGAGED OUR FAITH-BASED COMMUNITY AND WE ENCOURAGE EVERYBODY TO CALL THAT HOTLINE NUMBER, 888-811-1121, FOR INFORMATION TO HAVE THESE CHILDREN ADOPTED IN THEIR HOMES TO BE PART OF THEIR FAMILY SO WE WILL HAVE A GREATER, STRONGER NATION. SO LET ME GIVE THIS PROCLAMATION ON BEHALF OF THE BOARD OF SUPERVISORS AS WE PROCLAIM THE MONTH OF MAY AS FOSTER CARE AWARENESS MONTH. [ APPLAUSE ] 

TRISH PLOEHN: GOOD MORNING, EVERYBODY. THANK YOU, SUPERVISOR ANTONOVICH AND ALL OF THE BOARD FOR ACKNOWLEDGING THIS SPECIAL TIME OF YEAR. IN HONOR OF THE FOSTER CARE AWARENESS MONTH, I WOULD LIKE TO THANK EVERYBODY WHO DEDICATES THEMSELVES TO THE CHILDREN OF LOS ANGELES, A SPECIAL THANK YOU TO THE COMMITTED STAFF OF D.C.F.S. AND ALSO TO ALL THE RELATIVES, FOSTER PARENTS, RESOURCE PARENTS, FOSTER FAMILY AGENCIES AND GROUP HOMES THAT MAKE HOMES FOR CHILDREN, SOMETIMES TEMPORARILY AND SOMETIMES PERMANENTLY FOR CHILDREN WHO CANNOT SAFELY REMAIN IN THEIR OWN HOMES. AS A COUNTY WHO HAS DEDICATED ITSELF TO MAKING CHILDREN A PRIORITY, WE HAVE MADE WONDERFUL STRIDES IN THIS COUNTY. CHILDREN ARE NOW SAFER. WE HAVE A REDUCED RELIANCE ON OUT OF HOME CARE. AND THERE IS A MUCH SHORTER TIME THAT CHILDREN HAVE TO REMAIN IN CARE BEFORE THEY CAN EITHER GO HOME SAFELY OR GO INTO AN ADOPTIVE HOME. THESE CHANGES HAVE SHOWN GREAT OUTCOMES. WE NOW HAVE JUST UNDER 19,000 CHILDREN IN OUT OF HOME CARE. THIS IS A REDUCTION FROM ALMOST 50,000 CHILDREN JUST 10 YEARS AGO. IN ADDITION, WE HAVE BEEN ABLE, OVER THE LAST TWO YEARS, TO FIND, LOCATE, AND CORRECTLY PROVIDE SERVICES TO OVER HALF OF THE CHILDREN THAT HAD BEEN RUN-AWAYS OR HAD BEEN ABDUCTED. AND WE HAVE MANY INNOVATIVE PROGRAMS, ONE OF WHICH IS OUR POINT OF ENGAGEMENT PROGRAM, WHICH FOCUSES ON STRENGTHENING THE COMMUNITY AS WELL AS THE FAMILY. AND THAT PROGRAM, I'M VERY PROUD TO TELL YOU IS BEING HONORED RIGHT NOW AS WE SPEAK UP IN SACRAMENTO AT THE STATEWIDE PROGRAM THAT SHOULD BE EXPANDED ACROSS CALIFORNIA. SO I THANK ALL OF YOU FOR THIS HONOR AND I WISH YOU A VERY GOOD DAY. [ APPLAUSE ] 

STEPHANIE CLANCY: THANK YOU VERY MUCH FOR HAVING OUR PROGRAM HERE. I'M WITH HEART GALLERY-LOS ANGELES, A PROGRAM OF DEPARTMENT OF CHILDREN AND FAMILY SERVICES. THIS PORTRAIT DISPLAY BEHIND ME IS JUST A SMALL SAMPLE OF OVER 500 KIDS RIGHT NOW IN L.A. COUNTY GROWING UP WITHOUT FAMILIES. AND MY GOAL AS THE PROGRAM MANAGER IS TO FIND A FAMILY FOR EACH OF THESE KIDS. WE HAVE VOLUNTEER PROFESSIONAL PHOTOGRAPHERS WHO GIVE THEIR TIME AND SKILLS TO GET A TRUE PICTURE OF THESE KIDS. IT CAPTURES THEIR HEART, THEIR SPIRIT, THEIR SOUL, AND WE HAVE LOTS OF HAPPY ENDINGS AS A RESULT. I'M PUTTING THESE GALLERY PORTRAIT DISPLAYS UP ALL OVER L.A. COUNTY, INCLUDING MALLS, SCHOOLS, EVENTS LIKE THIS, AND IT'S WORKING. I'D LIKE TO PRESENT OUR CALENDAR FOR 2008 TO SUPERVISOR ANTONOVICH, WHO HAS BEEN SUCH A WONDERFUL SUPPORTER OF ADOPTIONS IN OUR COUNTY. AND I'M ALSO GOING TO BE PROVIDING CALENDARS FOR EACH OF THE SUPERVISORS HERE TODAY. THANK YOU. [ APPLAUSE ] 

SUP. KNABE: MADAM CHAIR, MEMBERS OF THE BOARD, AT THIS TIME I'D LIKE TO CALL UP JANELLE HOLT ALONG WITH DORA JACILDO, EXECUTIVE DIRECTOR OF CHILDREN TODAY, AND DR. GARY MANGIOFICO, WHO IS THE C.E.O. OF LOS ANGELES UNIVERSAL PRESCHOOL, BETTER KNOWN AS L.A.U.P. JANELLE IS THE HEAD TEACHER AT CHILDREN TODAY'S PLAYHOUSE WEST IN LONG BEACH, AND IT MAKES ME PROUD AND VERY PROUD TO HONOR HER TODAY AS THE L.A.U.P. PRESCHOOL TEACHER OF THE YEAR IN THE FOURTH DISTRICT. THERE WERE MANY DISTINGUISHED CANDIDATES ALL WORTHY OF RECOGNITION. HOWEVER, MRS. HOLT AND CHILDREN TODAY AS AN ORGANIZATION BRING A VERY UNIQUE PERSPECTIVE TO THIS ISSUE THROUGH THEIR WORK WITH HOMELESS CHILDREN AND FAMILIES. THE ISSUE OF HOMELESSNESS HAS BECOME INCREASINGLY PREVALENT, NOT ONLY IN THE FOURTH DISTRICT BUT ACROSS OUR ENTIRE COUNTY. SADLY, WE ARE SEEING AN INCREASING NUMBER OF FAMILIES IN THIS SITUATION. WE HAVE ALLOCATED A SIGNIFICANT AMOUNT OF RESOURCES, TIME AND ENERGY TOWARDS IMPROVING, ENHANCING, AND EXPANDING THE SYSTEMS OF CARE THAT ARE IN PLACE TO HELP THESE FAMILIES TRANSITION OFF THE STREETS AND INTO HOUSING AND A BETTER LIFE AND OUR COMMITMENT IS UNWAVERING. BUT I BELIEVE AT THE END OF THE DAY, THE TRUE MEASURE OF OUR SUCCESS WILL BE FOUND IN THE EFFORT TO FOSTER THE ABILITY OF EACH OF THESE FAMILIES TO OVERCOME THE VERY PAINFUL REALITIES OF LOSS, TRAUMA AND POVERTY AND FEAR. THE MOST IMPORTANT ASPECT OF GETTING PAST THOSE HUGE CHALLENGES IS TO MAKE THE WELL BEING OF THE CHILDREN IN THESE SITUATIONS AND THESE FAMILIES THE NUMBER ONE PRIORITY. CHILDREN TODAY PLAYHOUSE IN LONG BEACH IS A UNIQUE PRESCHOOL AND CHILD DEVELOPMENT SETTING WHERE THESE CHILDREN CAN BE SUPPORTED IN A VERY SAFE ENVIRONMENT TO FIRST LEARN TO COPE WITH THE INSTABILITY OF HOMELESSNESS, BUT THEN TO BUILD THE INNER STRENGTH TO TRANSCEND IT. AND IT'S APPARENT TO ME IN LOOKING AT WHAT JANELLE HAS DONE THAT OBVIOUSLY HAS BEEN A VERY IMPORTANT PART OF THAT VISION. SHE HAS FOUND AMAZING WAYS OF STRETCHING THE LIMITS OF THE SO-CALLED TRADITIONAL EARLY CHILDHOOD EDUCATIONAL PROGRAMS TO SUIT THE MOST VULNERABLE POPULATION OF CHILDREN THAT WE HAVE. SO IT MAKES ME VERY PROUD AND I'M HUMBLED TO HONOR HER TODAY. SHE'S NOT ONLY THE FOURTH DISTRICT L.A.U.P. PRESCHOOL TEACHER OF THE YEAR, BUT OBVIOUSLY WITH THE WORK SHE'S DONE, SHE'S ONE OF THE TRUE HEROES OF THIS COUNTY. CONGRATULATIONS, JANELLE. [ APPLAUSE ] 

DR. GARY MANGIOFICO: GOOD MORNING, SUPERVISORS, MADAM CHAIR, AND I WANT TO THANK YOU, SUPERVISOR KNABE, FOR INVITING ME TO SAY A FEW WORDS ON BEHALF OF ONE OF THE RECIPIENTS OF L.A.U.P.'S PRESCHOOL TEACHER OF THE YEAR AWARD. THE COUNTY OF LOS ANGELES SHOULD BE VERY PROUD OF A PRESCHOOL TEACHER WHO, JANELLE HOLT, WHO RECENTLY RECEIVED ONE OF SIX L.A.U.P. COUNTY-WIDE AWARDS FOR HER DEDICATED EFFORTS TO PREPARE HER PRESCHOOL STUDENTS TO SUCCEED IN KINDERGARTEN AND BEYOND. AND AS YOU INDICATED IN JANELLE'S CASE, THIS PRESTIGIOUS AWARD IS EXTRA SPECIAL BECAUSE OF THE EXTRAORDINARY CHALLENGES SHE AND HER STUDENTS FACE. EACH DAY, JANELLE STRIVES TO TEACH IN A WAY THAT HELPS TO ERASE FEARS AMONG HER STUDENTS OF THE PAINFUL REALITIES OF TRAUMA, LOSS, AND POVERTY CAUSED BY HOMELESSNESS. SHE ALSO HELPS HER STUDENTS COPE WITH THE REALITIES OF BEING HOMELESS BY GIVING THEM THE TOOLS THEY NEED TO TRANSITION SUCCESSFULLY INTO KINDERGARTEN. THE CHIEF EXECUTIVE OFFICER OF LOS ANGELES UNIVERSAL PRESCHOOL, I'M HONORED TO HELP RECOGNIZE JANELLE FOR HER COMMITMENT TO EXCELLENCE IN TEACHING, AND FOSTERING A CLASSROOM CLIMATE THAT IS CHARACTERIZED BY ENTHUSIASM FOR LEARNING, FOR ENGAGING OTHERS, INCLUDING PARENTS, AND SUPPORTING HER STUDENTS, LEARNING EXPERIENCE AND DEVELOPMENT NEEDS. JANELLE, YOUR CONTRIBUTION UPHOLDS L.A.U.P.'S COMMITMENT TONE SURE THAT EVERY FOUR-YEAR-OLD HAS EQUAL ACCESS TO QUALITY PRESCHOOL EDUCATION AND IS WELL PREPARED FOR KINDERGARTEN. CONGRATULATIONS ON A WELL-DESERVED AWARD. [ APPLAUSE ] 

JANELLE HOLT: I'M TRULY HONORED TO BE HERE. THANK YOU TO THE SUPERVISORS FOR HAVING KNEE AND THANK YOU TO SUPERVISOR KNABE FOR ARRANGING THIS PRESENTATION. I ALSO WOULD LIKE TO THANK L.A.U.P. FOR THEIR -- ALL THEIR WORK THAT THEY DO TO ENSURE THAT ALL CHILDREN HAVE ACCESS TO A QUALITY PRESCHOOL EDUCATION. AND I'M REALLY, REALLY PLEASED TO BE HERE. THANK YOU. [ APPLAUSE ] 

DORA JACILDO: THANK YOU. I JUST WANTED TO, FIRST OF ALL, SAY THAT TODAY ON MY CALENDAR, IT SAYS TEACHER OF THE YEAR DAY. AND SO TODAY IS A SPECIAL DAY IN BOTH RECOGNIZING ALL TEACHERS, SO I WANTED TO FIRST ACKNOWLEDGE HOW GRATEFUL WE ARE THAT YOU CHOSE THIS DAY TO RECOGNIZE JANELLE. BUT SECOND, I WANTED TO THANK THE FOURTH DISTRICT SUPERVISOR DON KNABE, YOUR AMAZING STAFF. NOT ONLY HAVE YOU BEEN THERE IN SUPPORT OF EVERYTHING THAT WE DO, BUT WE ALSO GET TO BENEFIT FROM BEING CELEBRATED BY YOU. SO WE THANK YOU FOR BEING SO THOUGHTFUL IN SUPPORTING OUR MISSION AND SO GENEROUS WITH YOUR TIME, WITH YOUR STAFF AND WITH YOUR RESOURCES. THANK YOU. [ APPLAUSE ] 

SUP. KNABE: THANK YOU. MADAM CHAIR, THAT'S MY PRESENTATIONS. 

SUP. ANTONOVICH: CHAIR, MEMBERS, TODAY WE WELCOME SEVERAL GUESTS TO JOIN US AS WE PROCLAIM THE MONTH OF MAY AS MENTAL HEALTH MONTH. WITH US IS DR. MARVIN SOUTHARD, WHO IS THE DIRECTOR OF OUR DEPARTMENT OF MENTAL HEALTH. KEN KONDO IS THE P.I.O. FOR THE DEPARTMENT. CLAUDIA MUNSEN, U.S. VETS, INC. STELLA MARCH, NATIONAL ALLIANCE ON MENTAL HEALTH. JOHN BOWL, OF THE AD COUNCIL AND GALINA LISS. JERRY LUBIN, CHAIR OF THE MENTAL HEALTH COMMISSION, ROCCO CHENG AND WES HANSEN OF PACIFIC CLINICS. MANY PEOPLE DON'T REALIZE, BUT ONE IN FIVE AMERICANS EACH YEAR IS AFFECTED BY MENTAL ILLNESS. AND THE OCCURRENCE OF MENTAL ILLNESS ALSO COMES WITH SUBSTANCE ABUSE, WHICH IS A SIGNIFICANT CONCERN THAT REQUIRES INTEGRATED MENTAL HEALTH TREATMENT. OUR COUNTY HAS MADE A COMMITMENT TO COMMUNITY-BASED SYSTEMS OF MENTAL HEALTHCARE FOR ALL OF ITS RESIDENTS. THIS IS A FUNDAMENTAL COMPONENT OF GENERAL HEALTH AND INDISPENSABLE TO PERSONAL WELL BEING, FAMILY AND INTERPERSONAL RELATIONSHIPS. THE LOS ANGELES COUNTY MENTAL HEALTH COMMISSION, ALONG WITH THE L.A. COUNTY DEPARTMENT OF MENTAL HEALTH, HAVE JOINED THE BOARD IN A FOCUSED EFFORT TO RAISE AWARENESS AND UNDERSTANDING OF MENTAL HEALTH AND MENTAL ILLNESS DURING THIS MONTH. THE DEPARTMENT AND COMMISSION WILL CO-SPONSOR THE ANNUAL RECOGNITION AWARDS IN MAY AND MENTAL HEALTH COMMUNITIES AROUND THE COUNTY WILL HOLD SPECIAL EVENTS. SO NOW WE HAVE THIS PROCLAMATION THAT WE WILL PRESENT AND THEN ASK OUR SPEAKERS TO SAY A FEW WORDS. ON BEHALF OF THE BOARD OF SUPERVISORS FOR THE MONTH OF MAY, WE DECLARE THIS MENTAL HEALTH AWARENESS MONTH. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW LOOK AT THE CAMERAS SO YOU'RE NOT BLOCKED BY THE PERSON IN FRONT OF YOU. 

DR. MARVIN SOUTHARD: I'D LIKE TO THANK SUPERVISOR ANTONOVICH AND THE REST OF THE BOARD FOR THE PROCLAMATION, BUT ALSO FOR THE LEADERSHIP YOU HAVE GIVEN US IN A VERY IMPORTANT WAY. ONE OF THE THINGS THAT WE ARE DOING IN OUR MENTAL SYSTEM THESE DAYS IN TRYING TO MAKE THE PUBLIC AWARE IS THAT THE FOCUS FOR WHAT WE DO IS NO LONGER ON PROGRAMS AND SERVICES. PROGRAMS AND SERVICES, EVEN THE BEST PROGRAMS AND SERVICES ARE ONLY A MEANS TO THE END, AND THE END THAT WE'RE TRYING TO REACH IS HOPE, WELLNESS, AND RECOVERY IN THE LIVES OF PERSONS SUFFERING FROM MENTAL ILLNESS IN THEIR FAMILIES. SO EVERYTHING THAT WE DO IS FOCUSED ON HOPE, ON WELLNESS AND RECOVERY IN PERSONS' LIVES. A SECOND THING THAT THE BOARD HAS SUPPORTED US IN DOING IS CREATING PARTNERSHIPS. THE WORK THAT WE'RE TRYING TO DO IN RAISING AWARENESS ABOUT MENTAL ILLNESS AND ITS EFFECTS IN PEOPLE'S LIVES CAN'T BE DONE ONLY BY THE MENTAL HEALTH DEPARTMENT. WE NEED OUR COMMUNITY PARTNERS IN AGENCIES BUT ALSO IN THE ADVERTISING INDUSTRY TO MAKE THAT MESSAGE FORWARD, SO EVERYBODY GETS TO KNOW THAT THERE IS HOPE FOR RECOVERY IN THE LIVES OF PERSONS WITH MENTAL ILLNESS. SO I WANTED TO THANK YOU FOR YOUR SUPPORT IN THAT REGARD. AND ALSO ONE OF THE AREAS WHERE THERE NEEDS TO BE A SPECIAL EMPHASIS ON HOPE AND RECOVERY IS IN OUR RETURNING VETERANS. THEY HAVE GONE THROUGH A LOT, THEY'RE RETURNING TO THEIR COMMUNITIES AND THEY NEED OUR COMMUNITY SUPPORT SO THAT THEY ACHIEVE THE RECOVERY FROM THEIR EXPERIENCES. SO I'D LIKE TO INVITE DR. ROCCO CHENG FROM PACIFIC CLINICS, ONE OF OUR KEY PARTNERS, TO SAY A FEW WORDS ABOUT WHAT WE'RE TRYING TO DO ABOUT CREATING HOPE, WELLNESS, AND RECOVERY IN LOS ANGELES COUNTY. 

ROCCO CHENG: THANK YOU, DR. SOUTHARD AND THANK YOU, SUPERVISOR ANTONOVICH. AT PACIFIC CLINICS, WE KNOW THAT EVERY DAY WE HAVE THE OPPORTUNITY TO HELP TURN A LIFE AROUND, AND THEREFORE, WE WELCOME THE OPPORTUNITY TO HELP RAISE THE PUBLIC AWARENESS OF MENTAL HEALTH, MENTAL ILLNESS, AND WE ALSO UNDERSTAND, AND THERE ARE SO MANY STIGMAS AND DISCRIMINATIONS ATTACHED TO MENTAL ILLNESS. THEREFORE, WE UNDERSTAND THAT IT IS SUCH AN IMPORTANT TASK FOR US TO WORK TOGETHER TO HELP ALLEVIATE THE UNNECESSARY PAIN AND SUFFERING ASSOCIATED WITH MENTAL ILLNESS. WE REALLY APPRECIATE THE BOARD OF SUPERVISORS FOR PROCLAIMING MAY AS THE MENTAL HEALTH AWARENESS MONTH. I BELIEVE STRONGLY THAT TOGETHER WE CAN MAKE A STRONG TEAM TO ADDRESS THIS ISSUE. BEING AN IMMIGRANT MYSELF, I UNDERSTAND THAT IN THE PROCESS OF IMMIGRATION, IT ALSO CAUSES A LOT OF UNNECESSARY STRESS, WITH THE FUNDING POSSIBILITY AND RESOURCES INTRODUCED BY MENTAL HEALTH SERVICE ACT, WE TRULY BELIEVE THAT BUILDING A NEW PARTNERSHIP WITH THE BOARD OF SUPERVISORS, WITH THE DEPARTMENT OF MENTAL HEALTH AND MANY, MANY OTHER COMMUNITY AGENCIES, WE COULD BEGIN TO ADDRESS THE ISSUE MUCH MORE EFFECTIVELY AND MORE EFFICIENTLY. SO, THANK YOU AGAIN FOR DECLARING MAY AS THE MENTAL HEALTH AWARENESS MONTH. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE'RE ALSO GOING TO DECLARE THE MONTH OF MAY AS MOTORCYCLE AWARENESS MONTH. AND WE HAVE REPRESENTATIVES FROM ABATE, WHICH IS AMERICAN BIKERS AIMED TOWARD EDUCATION OF CALIFORNIA. LARRY PFAFFLY, WHO IS THE CHAIRMAN OF THE BOARD. AND TIM TINAMEN. AND WE'RE HERE TALKING ABOUT SAFETY ON THE HIGHWAYS, AND THIS IS INTENDED TO HEIGHTEN AWARENESS OF MOTORISTS ON HIGHWAYS BY RECOGNIZING NATIONAL, STATE AND LOCAL SAFETY EVENTS FOR MOTORCYCLE RIDERS. THEY PROVIDE AN ECONOMICAL, ENVIRONMENTALLY FRIENDLY ALTERNATIVE TO AUTOMOBILE TRAVEL, AND ALSO HOBBIES FOR MANY OTHERS, AND CHARITABLE AND SOCIAL OUTINGS. 80% OF ACCIDENTS BETWEEN MOTORCYCLES AND AUTOMOBILES STEM FROM AUTOMOBILES BEING AT FAULT. WHAT ABOUT WHEN YOU HIT AN M.T.A. BUS, WHO'S FAULT IS THAT? WE GET A FEW OF THOSE AS WELL. IT'S VITAL THAT THE CITIZENS OF OUR COUNTY BE AWARE ON THE STREETS AND HIGHWAYS ABOUT THE NEED FOR SAFETY, BOTH FOR BUSES, MOTORCYCLES, AND AUTOMOBILES. SO LET ME PRESENT THIS PROCLAMATION TO YOU AND WISH YOU A SAFE YEAR. 

LARRY PFAFFLY: I WANT THANK TO THANK SUPERVISOR ANTONOVICH AND THE OTHER MEMBERS OF THE L.A. COUNTY BOARD OF SUPERVISORS FOR PROCLAIMING MAY AS MOTORCYCLE AWARENESS MONTH IN LOS ANGELES COUNTY. TIM AND I ACTIVELY PROMOTE MOTORCYCLE SAFETY AND MOTORCYCLE AWARENESS. I'VE COME ACROSS SOME INFORMATION RECENTLY THAT'S DISTURBING. AS WE SAY EVERY TIME, MOTORCYCLE DEATHS CONTINUE TO RISE, FROM 318 IN CALIFORNIA IN 2002 TO 433 IN 2006. THE THING THAT I FOUND VERY INTERESTING ABOUT THIS DATA IS THE MAJORITY OF MOTORCYCLE ACCIDENTS OCCUR BETWEEN NOON AND 5:00 P.M. THIS IS NOT THE MAJOR RUSH HOUR TIMES, THIS IS NOT WHEN PEOPLE ARE HECTIC, WHERE THEY'RE TRYING TO GET HOME OR TO WORK VERY QUICKLY. AND LIKE SUPERVISOR ANTONOVICH STATED, 80% OF THE ACCIDENTS ARE THE FAULT OF THE CAR DRIVERS. PLEASE TRY NOT TO BE ONE OF THOSE DRIVERS. MOTORCYCLISTS ARE EVERYWHERE AMONG US. THERE ARE HUSBANDS, WIVES, CHILDREN, NEIGHBORS, THEY'RE GRANDPA AND GRANDMA. I'M GRANDPA. THEY ARE YOU, THEY ARE ME. PLEASE HELP US TRY TO KEEP MOTORCYCLISTS SAFER. THE L.A. COUNTY BOARD OF SUPERVISORS PROCLAIMING MAY AS MOTORCYCLE AWARENESS MONTH IN LOS ANGELES COUNTY IS A STEP TOWARDS HELPING MOTORCYCLISTS RIDE MORE SAFELY. THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE'RE GOING TO PROCLAIM ASIAN AMERICAN PACIFIC ISLANDER HERITAGE MONTH FOR THE MONTH OF MAY. PERFECTO TOBIAS, PRESIDENT OF LOS ANGELES COUNTY FILIPINO AMERICAN EMPLOYEES ASSOCIATION, IRENE HAMA, THE PRESIDENT OF THE ASIAN-AMERICAN EMPLOYEES ASSOCIATION, DAVID NIENDO, PRESIDENT OF THE COUNTY VIETNAMESE EMPLOYEES ASSOCIATIONS AND T.B. ZHITHAN, THE PRESIDENT OF THE L.A. COUNTY CAMBODIAN AMERICAN EMPLOYEES ASSOCIATION, AS WE JOIN TOGETHER TO PROCLAIM MONTH OF MAY AS ASIAN/PACIFIC ISLANDER HERITAGE MONTH. OUR COUNTY IS VERY STRENGTHENED BY THE RICH CULTURAL DIVERSITY OF ALL OF OUR PEOPLE AND WE ARE BLESSED TO BE A NATION THAT WELCOMES INDIVIDUALS OF ALL RACES, RELIGIONS, AND CULTURAL BACKGROUNDS. THE TRADITIONS AND VALUES OF THE ASIAN/PACIFIC AMERICAN COMMUNITY, LOVE OF FAMILY, ENTREPRENEURSHIP, EXCELLENCE IN EDUCATION AND COMMUNITY SERVICE HAS STRENGTHENED US AS A NATION. DURING THIS MONTH, WE CELEBRATE THE CONTRIBUTIONS OF THOSE TALENTED AND HARD-WORKING CITIZENS WHO HAVE RECOGNIZED THEIR RICH LEGACY AND INGENUITY, PERSEVERANCE, AND ACHIEVEMENT. MANY OF THESE ASIAN/PACIFIC IMMIGRANTS HAVE COME TO AMERICA TO DISCOVER THE PROMISE OF OUR NATION AND TO RECOGNIZE THEIR DREAMS, THEIR CONTRIBUTIONS WERE VERY CRITICAL IN CREATING A VERY STRONG ECONOMY THAT HAS CREATED MORE JOBS AND HAVE LOWER UNEMPLOYMENT RATE SINCE THE 1970S. ASIAN-AMERICAN PACIFIC AMERICANS HAVE WORKED TIRELESSLY TO BUILD OUR NATIONAL RAILROAD INFRASTRUCTURE, PAVING THE WAY FOR OUR WESTERN EXPANSION AND GROWTH AS A WORLD LEADER. THEY ALSO ARE HELPING TO SHAPE L.A. COUNTY'S FUTURE IN THE MEDICAL AND EDUCATIONAL FIELDS, AND PUBLIC SERVANTS, SCIENTISTS, AND EXPLORERS, AS WE KNOW HOW WELL THE MARS PROBE AND OTHERS IN OUTER SPACE HAVE BEEN ACHIEVED BY PEOPLE FROM ALL ETHIC GROUPS AND MANY FROM THE ASIAN COMMUNITY WHO HAVE BEEN PART OF THOSE PROGRAMS. THEY CHALLENGE THE MINDS OF OUR NEXT GENERATION, THEY EXPAND COMMERCE, INNOVATION AND PROBE THE FRONTIERS OF SPACE WHILE THEY SEARCH FOR THE CURES OF THE WORLD'S DISEASES. SO SINCE THE EARLIEST DAYS OF AMERICA, PEOPLE OF ALL CULTURES HAVE TRAVELED TO OUR NATION SEEKING THE PROMISE OF FREEDOM WITH RESPONSIBILITY, OPPORTUNITY AND JUSTICE AS AN INTEGRAL PART OF OUR SOCIETY. SO WE NOW PROCLAIM MAY AS ASIAN/PACIFIC AMERICAN HERITAGE MONTH. [ APPLAUSE ] 

SPEAKER: THANK YOU, SUPERVISOR ANTONOVICH AND MEMBERS OF THE BOARD. ON BEHALF OF ALL THE ASIAN-AMERICAN EMPLOYEES ASSOCIATIONS IN L.A. COUNTY, WE ENCOURAGE ALL EMPLOYEES AND EVERYONE TO VISIT THE ASIAN COMMUNITY AND EXPERIENCE THE MANY CULTURES AND FOOD FOR AN EXCITING EXPERIENCE. THANK YOU. 

SUP. ANTONOVICH: NOW WE'RE GOING TO RECOGNIZE AG DAY L.A., AND WITH US IS RICHARD IZUKA, WHO IS THE CHIEF DEPUTY OF AGRICULTURAL COMMISSIONER OF WEIGHTS AND MEASURES, PAUL DUFORD, DEPUTY DIRECTOR OF THE DEPARTMENT, AND LAURA BLANK, EXECUTIVE DIRECTOR OF L.A.C.O.E. L.A. COUNTY FARM BUREAU, AND MARY LANDAU, PAST PRESIDENT CALIFORNIA WOMEN FOR AGRICULTURE. WE PROCLAIM MAY 14 THROUGH 15TH AS AG DAY L.A., RECOGNIZING THE IMPORTANCE AND VALUE IN LEARNING WHERE OUR FOOD AND FIBER COME FROM. OUR COUNTY HAS RECOGNIZED THIS IMPORTANT GOAL OF AGRICULTURAL AWARENESS IN DECLARING THIS MAY 14TH THORUGH 14TH AS AG DAY. IN HONOR OF THIS TWO-DAY EVENT AT THE FAIRPLEX IN POMONA TO INTRODUCE AGRICULTURAL SCIENCES TO OUR STUDENTS. THE DEPARTMENT, ALONG WITH THE CALIFORNIA WOMEN FOR AGRICULTURE IN THE 48TH AGRICULTURE DISTRICT AGRICULTURAL ASSOCIATION HAVE JOINED TOGETHER TO FORM A FOUNDATION WHOSE MISSION IS THE ANNUAL PRODUCTION OF THIS EVENT. INFORMATION REGARDING A WIDE ARRAY OF AGRICULTURE PRODUCTION, THEY METHODOLOGIES AND SUPPORT SERVICES WILL BE PRESENTED TO MORE THAN 4,500 OF OUR STUDENTS FROM AROUND THE COUNTY. THIS HAS SPECIAL SIGNIFICANCE AS THE COUNTY ENHANCES ITS EFFORTS TOWARD ACHIEVING EXCELLENCE IN THE WELL BEING OF CHILDREN AND FAMILIES AND ITS STRATEGIC PLAN. SO WE HAVE NOW PROCLAIMED THE 14TH AND 15TH AG DAY L.A. AND WE NEED MORE FIBER, MORE BROCCOLI, MORE GREENS AND MORE EXERCISE. RIGHT? AND NO COKES. RIGHT? OKAY. 

SUP. ANTONOVICH: RICHARD, YOU'RE ON. 

RICHARD IZUKA: THANK YOU VERY MUCH, SUPERVISOR ANTONOVICH. I'D LIKE TO THANK BOTH YOU AND THE BOARD FOR YOUR SUPPORT IN THIS EVENT. THIS IS OUR SEVENTH ANNIVERSARY. THOUSANDS OF THIRD AND FOURTH GRADERS HAVE HAD THE OPPORTUNITY TO LEARN WHERE THEIR FOOD, FIBER, AND WATER COME FROM, THANKS TO THIS EVENT. AND IN FACT, IN THE APRIL COUNTY DIGEST, THERE'S ACTUALLY AN ARTICLE ABOUT AG DAY L.A. FOR THIS YEAR. WE BROUGHT GIFTS TODAY FOR EACH ONE OF THE SUPERVISORS. AND THIS GIFT IS IN KEEPING WITH THE BOARD'S DIRECTION ON THE REDUCTION OF THE USE OF PLASTIC BAGS. SO WE HAVE A REUSEABLE AGGIE SHOPPING BAG FOR YOU. ANYWAY, WE THANK YOU VERY MUCH. 

MARY LANDAU: ON BEHALF OF CALIFORNIA WOMEN FOR AGRICULTURE AND THEIR FOUNDING OF AG DAY L.A., I WANTED TO SAY IF YOU WEAR CLOTHES OR IF YOU EAT FOOD, YOU'RE INVOLVED IN AGRICULTURE. AND IT'S REALLY IMPORTANT TO KNOW MORE ABOUT IT, SO WE'RE HERE TO EDUCATE THE CHILDREN AND COME ALONG WITH US. 

LAURA BLANK: HI. I'M LAURA BLANK WITH THE FARM BUREAU. WE'D LIKE TO INVITE ALL OF YOU TO COME OUT AND SEE AG DAY L.A. AND SEE ALL THE CHILDREN LEARNING ABOUT AGRICULTURE. IT'S A GREAT EVENT. THANK YOU. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE HAVE A PAIR, THESE ARE TWO LITTLE CUTE -- I DON'T KNOW, ARE THEY BROTHER AND SISTER? BROTHER AND SISTER. ONE TAKES AFTER THE FATHER, ONE TAKES AFTER THE MOTHER, OBVIOUSLY. THEY'RE A SPANIEL MIX, LOLA AND PACO. THEY'RE EIGHT WEEKS OLD. YOU CAN CALL (562) 728-4644 AND LET'S SEE, THIS IS PACO. YOU ALWAYS HAVE TO CHECK THE PLUMBING, ALWAYS HAVE TO CHECK. HERE WE GO. OKAY. THEY'RE LOOKING FOR A LITTLE HOME. NOW THEY GO AS A SET OR YOU CAN BE VERY CRUEL AND TAKE ONE. BUT AS ONE WHO HAS TWO LITTLE SISTER LITTLE MINATURE DACHSIES, THEY GO BETTER AS A SET, THEN THEY HAVE A COMPANION WHEN YOU'RE NOT HOME. SO, ANYWAY, THESE ARE VERY CUTE. LOOK AT THEM. ANYBODY IN THE AUDIENCE? HUH? THEY'RE NOT LIKE THE PIT BULL THAT BITES, NOW. OKAY. I MEAN, THIS ONE IS GOING TO GIVE YOU A BIG KISS WHEN YOU COME HOME. TIME OUT, OKAY. ANYWAY, THESE LITTLE CUTIES WOULD LIKE TO BE ADOPTED, SO YOU CAN CALL THE NUMBER OR THOSE THAT ARE HERE. AND WE HAVE OTHERS JUST AS NICE AND SWEET, WITHOUT BOWS OR WITH BOWS. LOOK AT THAT. ZEV, BARBARA WOULD LOVE YOU TO BRING THESE HOME. OKAY. 

SUP. BURKE, CHAIR: WHILE SHE'S COMING UP, I CAN START. I'LL DO MY ADJOURNMENTS AND THEN AS SOON AS GLORIA GETS HERE -- I MOVE THAT WHEN WE ADJOURN TODAY, THAT WE ADJOURN IN THE MEMORY OF TOMMY TUCKER, A LONG-TIME LOS ANGELES COUNTY RESIDENT, WHO RECENTLY PASSED AWAY ON APRIL 19TH. HE OWNED AND OPERATED TOMMY TUCKER'S PLAYROOM ON WASHINGTON BOULEVARD FOR OVER 23 YEARS. HE WAS ALSO A BAIL BONDSMAN FOR 40 YEARS. HE WAS THE FIRST AFRICAN-AMERICAN TO HIRE A FEMALE BARMAID IN THE STATE OF CALIFORNIA. HE HAD THE FIRST AFRICAN-AMERICAN ESTABLISHMENT IN LOS ANGELES TO ACCEPT AN AMERICAN EXPRESS CARD. HE HAD AN IMPRESSIVE PHOTO GALLERY OF OVER 450 PHOTOGRAPHS OF MANY ENTERTAINERS, POLITICIANS, ATHLETES AND DEAR FRIENDS. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE. WILMA MARSHALL; HIS CHILDREN, CHRISTOPHER, BRANDON, JAMES, AND MATTHEW TUCKER; AND HIS IN-LAWS, TOMMIE AND HARRIET MARSHALL. AND MAYBELL HOWARD, LONG TIME SECOND-DISTRICT RESIDENT WHO PASSED AWAY RECENTLY AT THE AGE OF 89. DURING HER LIFETIME, SHE ASSISTED IN RAISING AND CARING FOR FIVE GENERATIONS OF CHILDREN, GRANDCHILDREN, GREAT GRANDCHILDREN, AND GREAT, GREAT GRANDCHILDREN. SHE LEAVES TO CHERISH HER MEMORY HER DAUGHTER, SALLY SMITH, ALONG WITH A HOST OF FAMILY AND FRIENDS. AND JOSEPHINE "JOSIE" SHACK, LONG-TIME SECOND DISTRICT RESIDENT AND MOTHER OF ACTIVE FLORENCE-FIRESTONE COMMUNITY MEMBER, JACKIE STEVENSON. SHE PASSED AWAY ON APRIL 19TH. SHE LEAVES TO CHERISH HER MEMORY HER DAUGHTERS, JOYCE ROSS, JOANN REED AND, WANDA BUCKLEY; HER SONS, JACKIE STEVENSON, AND ROBERT SHACK, JUNIOR; ALONG WITH A HOST OF FAMILY AND FRIENDS. AND RUTH BROTHERS BERRY, A LONG-TIME RESIDENT OF THE OF THE SECOND DISTRICT, WHO PASSED AWAY ON MONDAY, MAY 5TH. SHE IS SURVIVED BY HER HUSBAND, LEROY BERRY. THEY WERE BOTH VERY ACTIVE IN THE EDUCATION COMMUNITY AND IN DEMOCRATIC POLITICS. AND SHE WILL BE SORELY MISSED. I WILL START CALLING THE ITEMS THAT WERE HELD FOR THE PUBLIC. 38. WHO IS HOLDING THAT? IS THAT MR. ARNOLD SACHS? OKAY. I'D LIKE TO ASK DR. CLAVREUL TO COME FORWARD. WE'LL START WITH 38, AND THEN I'LL TAKE 12 LAST BECAUSE KNABE WANTS TO SPEAK ON THAT AS WELL. DIRECTOR OF HEALTH SERVICE AND CHIEF EXECUTIVE TO REPORT BACK WITHIN 14 DAYS. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. ON ITEM 38, I AM -- HOLD ON A MINUTE. I'M STILL SURPRISED THAT WE ARE USING 23 REGISTRIES. IF WE ARE DOING SO WELL AT HIRING NURSES LIKE WE HAVE BEEN TOLD REPEATEDLY, WHY ARE WE USING 23 DIFFERENT REGISTRIES? DOES NOT SOUND TOO GOOD. ON ITEM NUMBER 12 -- 

SUP. BURKE, CHAIR: LET ME DO 38. MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 39? 

DR. GENEVIEVE CLAVREUL: OH, 39. YOU SAID NUMBER 12. 

SUP. BURKE, CHAIR: NO, I'LL TAKE THAT LAST. 

DR. GENEVIEVE CLAVREUL: ON ITEM 39, I AM CONCERNED THAT WE ARE HIRING -- AGAIN, WE ARE OUTSOURCING FOR A HOSPITAL PHYSICIAN. I THINK IT WOULD BE BENEFICIAL TO THE COUNTY TO HAVE OUR OWN HOSPITAL TO DIRECT THE PATIENT CARE. THAT WOULD MAKE A LOT OF SENSE, YOU KNOW, AND I'M VERY CONCERNED OF THAT, ESPECIALLY WHERE WE ARE TALKING ABOUT A OBLIGATION OF $21 MILLION. I THINK THAT'S PRETTY STEEP. I WOULD LIKE FOR YOU TO LOOK AT THAT SPECIFIC ITEM. ON NUMBER 12 -- 

SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY ANTONOVICH. WITH OBJECTION, SO ORDERED. ITEM 39 IS APPROVED. ON NUMBER 96? 

DR. GENEVIEVE CLAVREUL: WHICH ONE? 

SUP. BURKE, CHAIR: 96. 

DR. GENEVIEVE CLAVREUL: 96. WELL YOU KNOW, YOU'VE GOT TO GIVE ME MORE THAN THREE MINUTES, I HOPE, FOR ALL OF THOSE ITEMS. BECAUSE RIGHT NOW I SHOW ONLY ONE MINUTE AND 22 SECONDS. 

SUP. BURKE, CHAIR: IF YOU WANT TO SPEAK LONGER ON IT, IT'S OKAY. 

DR. GENEVIEVE CLAVREUL: I'M QUITE GOOD TO DELIVER IN A SHORT PERIOD OF TIME, YOU HAVE TAUGHT ME THAT. BUT ANYWAY, ON 96, AGAIN, WHY IS IT TAKING SO LONG TO GET A REPORT? I MEAN, WE HAD ASKED FOR THAT TYPE OF INFORMATION LAST YEAR. I MEAN, THAT SHOULD BE AN ONGOING INFORMATION. A FEW WEEKS AGO, I REMEMBER SUPERVISOR MOLINA DEMANDING, YOU KNOW, ALL OF THAT SPECIFICALLY AND IT IS AGAIN POSTPONED TO JUNE 4TH. DOESN'T MAKE ANY SENSE. ANYWAY, ON -- WHICH ITEM DO YOU WANT TO GO ON TO? 

SUP. BURKE, CHAIR: MOVED BY KNABE ON 96-- 

CLERK SACHI HAMAI: MADAM CHAIR, AN 96, THAT ITEM IS BEING CONTINUED TO JUNE 4TH. 

SUP. BURKE, CHAIR: OKAY. WITHOUT OBJECTION, IT'S CONTINUED TO JUNE 4TH. 97-A. 

DR. GENEVIEVE CLAVREUL: NO, WE EXTENDED THE C.E.O. POWER, WE HAD A WHOLE BUNCH OF DEPUTY UNDER HIM. AND RIGHT NOW ALMOST EVERY ITEM IS POSTPONED. SOMETHING WRONG IN THAT PICTURE. WHICH ITEM? 

SUP. BURKE, CHAIR: 97-A, NURSE RECOGNITION WEEK. 

DR. GENEVIEVE CLAVREUL: WELL, I THINK ON THIS ONE, I WILL HELP YOU, SINCE I AM A NURSE, AND I'VE WRITTEN A GOOD ARTICLE ABOUT NURSES' WEEK, I WOULD LIKE FOR YOU SHARE IT WITH MY COLLEAGUE NURSES IN THE COUNTY OF LOS ANGELES. 

SUP. BURKE, CHAIR: OKAY. THANK YOU. MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. YOU WERE ALSO HOLDING CS-3. 

DR. GENEVIEVE CLAVREUL: YES. YOU KNOW, I DON'T LIKE IT, I DON'T LIKE EVERYTHING DONE UNDER THE CLOAK OF SECRECY. EVERYTHING DONE WITH MARTIN LUTHER KING IS DONE THAT WAY. NOTHING HAS BEEN OPEN AND, YOU KNOW, THE BEST WAY TO DIFFUSE CONCERN FROM THE PUBLIC IS TO BE TRANSPARENT. AND I THINK MANY OF US WOULD NOT BE SO CRITICAL IF WE WERE NOT, YOU KNOW, TOTALLY MISGUIDED. ON CS-3, ALL YOU'RE TALKING ABOUT IS REAL ESTATE. YOU ARE NOT TALKING DOWN ABOUT ANYBODY RUNNING THE-- AN OPERATOR FOR THE HOSPITAL. I THINK THAT SHOULD BE. AND I WANT TO USE THAT ISSUE TO ALSO BRING THE INTERIM APPOINTMENT OF DR. SCHUNHOFF. DR. SCHUNHOFF, I THINK YOU ARE TRYING TO BRING THE PETER PRINCIPAL TO ITS BEST LEVEL. BECAUSE LET ME TELL YOU, I'VE BEEN MONITORING THIS BOARD SINCE 1999. AND I CAN TELL YOU, DR. SCHUNHOFF WOULD BE THE LAST PERSON I WOULD APPOINT TO DIRECT THE FINANCE OF D.H.S. IT WAS IN THE PASADENA STAR NEWS IN 2002, WHEN DR. SCHUNHOFF SAID IT WOULD BE A DAUNTING TASK TO ACCOUNT FOR $83 MILLION. I DON'T KNOW ABOUT YOU, BUT THAT THAT REALLY CONCERNS ME. AND THAT'S A PERSON YOU ARE PUTTING IN CHARGE OF DEALING WITH THE BUDGET OF D.H.S. WHERE WE ARE A MILLION DOLLARS IN THE HOLE. I MEAN, I CANNOT EVEN BELIEVE THAT. YOU DID NOT NEED AN INTERIM PERSON, YOU HAVE MR. FUJIOKA THAT WE'RE PAYING HANDSOMELY TO BE IN CHARGE OF THAT DEPARTMENT. AND HIS MULTIPLE DEPUTIES WE HAVE HAD. SO, ANYWAY, I THINK THOSE COUPLE OF ARTICLES WILL STAND FOR THE RECORD AND I THINK THAT THE MORE INCOMPETENT YOU ARE IN L.A. COUNTY, THE MORE LIKELY YOU ARE TO BE HIRED OR KEPT. I THINK MAYBE WE SHOULD MAKE A DAY TO RECOGNIZE THE PUBLIC OF L.A. COUNTY. AND I THINK THIS COULD BE A TIME WHERE NOW WE SHOULD BE RECOGNIZED FOR WHAT WE DO FOR THE COUNTY. BECAUSE SOME OF US ARE EXPERT AND I FEEL I'M TALKING FROM AN EXPERT POINT OF VIEW. BUT OF COURSE I DON'T CHARGE YOU FOR ANYTHING BECAUSE I'M DOING BECAUSE IT'S THE RIGHT THING. AND I'M NOT ONE OF YOUR SYCOPHANTS. BUT ANYWAY ONE DAY WILL COME WHEN WE GO TO VOTE -- 

SUP. BURKE, CHAIR: GO AHEAD AND GO TO 12. 

DR. GENEVIEVE CLAVREUL: AND EXPAND IT FROM FIVE TO NINE. TIME HAVE COME. 

SUP. BURKE, CHAIR: YOU NEED TO COMMENT ON 12. 

DR. GENEVIEVE CLAVREUL: 12. YOU KNOW, IT'S A FARCE OF THE PROCESS HERE, BUT THAT'S OKAY. YEAH BUT YOU KNOW, IT'S OUT OF CONTEXT. IT'S OUT OF CONTEXT. I DON'T CARE. YOU KNOW, THE SAME -- TO ASK TO DO IT, YOU KNOW, COME BACK LATER IS ABSURD. I MEAN, THAT THIS KIND OF STATISTIC YOU PEOPLE SHOULD HAVE. ALL THEY WOULD HAVE TO DO IS PUSH A COUPLE BUTTONS ON THE COMPUTER AND TELL YOU HOW MANY VACANCIES THEY HAVE. IT'S ABSURD THAT THEY ASK YOU A WEEK TO COME BACK WITH THAT INFORMATION. I MEAN, WE'RE SPENDING BILLIONS IN THIS COUNTY AND NOBODY IS DOING THE WORK. I THINK THERE'S SOMETHING WRONG IN THAT PICTURE. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. SUPERVISOR KNABE, YOU WERE HOLDING 12. 

SUP. KNABE: ABSOLUTELY, I WAS HOLDING THE ITEM. I JUST WANTED TO MAKE IT CLEAR WHAT I WAS ASKING FOR HERE. THE REASON I HELD THIS ITEM, AND BECAUSE IT'S REALLY -- THIS INFORMATION TO ME IS VERY, VERY IMPORTANT THAT WE INVESTIGATE EVERYTHING IN A DEPARTMENT THAT IS FACING A BUDGET DEFICIT OF UP TO $300 MILLION FOR THE NEXT FISCAL YEAR. SOME OF THE INFORMATION THAT WE HAVE SEEN INDICATE THAT THE DEPARTMENT WORKLOAD IS MUCH LOWER THAN IT WAS A FEW YEARS AGO, YET THE NUMBER OF THE DEPARTMENT STAFF HAS REMAINED THE SAME AND IN SOME CASES GOTTEN LARGER. SO WE NEED TO LOOK AT THE MAGNITUDE. AS AN EXAMPLE, FROM 2003/2004, THE NUMBER OF PATIENT DAYS AT OUR HOSPITALS HAS DROPPED FROM 574,254 PATIENT DAYS IN '03/'04 TO 492,636 IN '07/'08, WHICH IS ABOUT AN 82,000 REDUCTION. THE SAME THING HAS HAPPENED IN ADMISSIONS AND THE SAME THING HAS HAPPENED IN DAILY CENSUS. SO IT'S REALLY IMPORTANT THAT WE LOOK AT ALL THESE ISSUES AS WE, YOU KNOW, DEAL WITH THE VERY SIGNIFICANT ISSUE IN THE HEALTH DEPARTMENT. THEN AGAIN, THE OTHER ISSUE INSIDE THE HEALTH DEPARTMENT THAT IS GRAVE CONCERN AND I HOPE THE C.E.O. AND HUMAN RESOURCES AND EVERYTHING ELSE, IS THE NUMBER OF PEOPLE, BECAUSE OF LIABILITY ISSUES THAT ARE ON THE PAYROLL, BUT ACTUALLY NOT WORKING AT ALL, AND SO I HOPE THAT'S PART OF THE REPORT BACK AS WELL, SO WITH THOSE COMMENTS, I'D MOVE THE ITEM. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. WE HAVE ITEM 48. MR. SACHS, AND WHEN YOU COME UP WE'RE GOING TO CALL YOUR ITEMS. BRING EVERYTHING WITH YOU, PLEASE. WE'RE CALLING ITEM 48. 

ARNOLD SACHS: GOOD MORNING AND WELCOME BACK. ALTHOUGH, WHO KNOWS? HOW WAS WASHINGTON? ITEM 48, ONE ON MY ALL-TIME HIT PARADE. SUNSHINE CANYON LANDFILL ENFORCEMENT AGENCY. YOU ACTUALLY ARE GOING TO GET INVOLVED IN THE SUNSHINE CANYON LANDFILL ENFORCEMENT AGENCY WITH THE CITY OF LOS ANGELES. YET WHEN THE ITEM WAS ON THE AGENDA LAST YEAR, YOU WENT AHEAD AND APPROVED AN INCREASE FROM 6,000 TONS PER DAY, 36,000 TONS A WEEK, TO 12,100 TONS PER DAY, 66,000 TONS PER WEEK, AND HAD A LAME EXCUSE FROM SOMEBODY SAYING THAT THE DIFFERENCE BETWEEN THE 72.6, WHAT THE MATH ADDS OUT TO BE, AND THE 66,000 TONS WAS SOIL THAT WAS USED AS FILL FOR COVERING THE LANDFILL SO THAT THE DEBRIS WOULDN'T BLOW AWAY. THAT BEING THE CASE, THE ITEM THAT YOU APPROVED WAS FOR INTAKE, NUMBER ONE. AND, NUMBER TWO, IF YOU WERE USING SOIL AT THE NEW RATE, YOU WOULD HAVE BEEN USING SOIL AT THE OLD RATE SO THAT THE LANDFILL WOULDN'T BE 36,000 TONS. AND YET YOU WANT TO BE IN COMPLIANCE WITH STATE LAWS AND REGULATIONS. I'D LIKE TO KNOW WHAT THEY THINK WHEN THEY SEE THAT ITEM ON THE AGENDA OR THEY'LL NEVER SEE IT. THANK YOU FOR YOUR TIME AND YOUR ANSWERS. 

SUP. BURKE, CHAIR: THE NEXT TIME WE'RE GOING TO CALL FOR YOU IS 52. MOVED BY ANTONOVICH ON 48, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. WE'RE CALLING 52. 

ARNOLD SACHS: 52, YOU'RE CALLING FOR FUNDING TO THE GOVERNANCE COUNCIL, FOR GATEWAY CITIES TO DO A STUDY E.I.S. FOR INTERSTATE 10 CORRIDOR. WHAT IS THE LIMITS -- WHAT DOES THE CORRIDOR BOUNDARIES CONSIST OF? BECAUSE WE'VE HAD DISCUSSIONS WITH M.T.A. OR M.T.A. HAS COME UP WITH CORRIDORS WHERE THE WILSHIRE CORRIDOR IS FROM WILSHIRE BOULEVARD TO WHO KNOWS WHERE. THAT'S WHY THEY ENDED UP DIGGING A SUBWAY AT FAIRFAX AND THIRD, WHICH HAS NO CONNECTION TO THE WILSHIRE CORRIDOR. AND YET IT WAS THE CAUSE FOR THE RED LINE BEING DISCONTINUED BACK IN THE MID '90S. ALSO, THE CITY OF L.A. JUST PASSED AN ITEM ON THEIR AGENDA FOR THE FINANCIAL AGREEMENT FOR THE MID-CITY CITY EXPOSITION LIGHT RAIL TRANSIT PROJECT. NOWHERE IN ANY INFORMATION ABOUT THE EXPOSITION LIGHT RAIL TRANSIT PROJECT IS THE TERM "MID-CITY" USED EXCEPT IN THE L.A. CITY COUNCIL. AND FINALLY -- 

SUP. BURKE, CHAIR: MOVED BY -- 52 -- I'M SORRY. 

ARNOLD SACHS: THE METRO BOARD HAS THE 710 FREEWAY COMMITTEE. WHAT IS THEIR -- WHAT IS THEIR PURVIEW, OR WOULD THAT BE REDUNDANT TO WHAT THE STUDY HELD BY THE GATEWAY CITY COUNCIL? THANK YOU FOR YOUR TIME AND YOUR ANSWERS. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY YAROSLAVSKY. ITEM 52 IS APPROVED. WE'LL CALL ITEM 55. 

ARNOLD SACHS: WELL, 55 -- ACTUALLY, 55 THROUGH 59, AND THE ONLY REASON I PUT 58 AND 56 DOWN, I WOULD DO 58 AND 56, IF YOU DON'T MIND, DEALING WITH FUNDING, THE DISTRICTS ARE PROVIDING $3.293 MILLION, A LITTLE OVER 3,293,000 DOLLARS FOR A PARA-TRANSIT SERVICE. MY CONCERNS WITH DISTRICT 58 AND 56 IS THAT ONE DISTRICT IS PROVIDING $175,000 FOR LA RAMBLA, AND THE OTHER DISTRICT IS PROVIDING ANOTHER $25,000 FOR THE SAME PARA-TRANSIT SERVICE. SO I FIND THAT A LITTLE BIT REDUNDANT, BUT I WOULD ALSO LIKE TO KNOW IS THIS MONEY BEING PROVIDED FOR PRIVATE NONPROFIT OR PRIVATE FOR-PROFIT PARA-TRANSIT PROVIDERS OR IS IT GOING TO THE COMMUNITIES THAT OFFER PARA-TRANSIT SERVICE? AND IF IT'S ALSO PRIVATE CONTRACTORS THAT PROVIDE SEDANS FOR A PORTION OF THEIR PARA-TRANSIT SERVICE INVOLVED IN THIS FUNDING. BECAUSE IF THEY'RE INVOLVED, I'D LIKE TO KNOW IF THERE'S A MECHANISM IN PLACE TO MAKE SURE THAT THE SEDANS THAT ARE LABELED ACCESS SERVICES AVAILABLE HAVE DRIVERS THAT ARE ACCESS SERVICES QUALIFIED. OTHERWISE, THEY'RE NOT ACCOUNTABLE FOR ACCESS SERVICES PROVIDING. AND ALSO, ONE OTHER THING, WITH THIS FUNDING BE PROVIDED, IS THERE AN AUDIT BY ACCESS SERVICES INCORPORATED, OR WILL IT BE PROVIDED BY THE RESTRUCTURED NONPROFIT INDEPENDENT AGENCY THAT I WILL BE READING FROM THE METRO COUNTY LIBRARY, WHICH I HAVE RIGHT HERE, LOS ANGELES TRANSIT HISTORY, THE ACCESS SERVICES. BECAUSE THEY ARE DIFFERENT AGENCIES, AND IT'S REDUNDANT THERE, TOO. THANK YOU FOR YOUR TIME AND YOUR ANSWERS. 

SUP. BURKE, CHAIR: ON 55, MOVED BY ANTONOVICH, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. ON 58, MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. ON 59, MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. I'LL TURN IT OVER TO SUPERVISOR YAROSLAVSKY FOR YOUR ADJOURNMENTS. 

SUP. YAROSLAVSKY: MADAM CHAIR, I DO NOT BELIEVE I HAVE ANY ADJOURNMENTS. I'D LIKE TO CALL UP -- OH, I'M SORRY. I DO HAVE ADJOURNMENTS. 

SUP. BURKE, CHAIR: WELL, WHILE YOU'RE DOING THAT, I'LL CALL UP 95. 

SUP. YAROSLAVSKY: OKAY. THANK YOU. 

SUP. BURKE, CHAIR: IS THAT HELD FOR DISCUSSION? IS THERE -- 

CLERK SACHI HAMAI: YES. THAT ITEM IS BEING HELD FOR DISCUSSION. 

SUP. BURKE, CHAIR: IS THERE ANYONE THAT WISHES TO CALL ANYONE FROM THE DEPARTMENT? IF NOT, MOVED BY KNABE, SECONDED BY -- 

CLERK SACHI HAMAI: ITEM 95, WE WERE HOLDING FOR DISCUSSION. 

SUP. BURKE, CHAIR: OKAY. 

SUP. YAROSLAVSKY: I THINK I WANTED TO SPEAK ON THAT. 

SUP. BURKE, CHAIR: ARE THERE SOME PEOPLE WHO HAVE ASKED TO SPEAK? 

CLERK SACHI HAMAI: 95, YES, THERE'S A COUPLE. 

SUP. BURKE, CHAIR: OH, HERE THEY ARE. WHY DON'T YOU DO YOUR ADJOURNMENTS? 

SUP. YAROSLAVSKY: OKAY. I HAVE TWO ADJOURNING MOTIONS. FIRST, ANTONIA MENA, COMMUNITY LEADER WHO SUCCUMBED TO BREAST CANCER AT THE AGE OF 44. WITH HER HUSBAND, JUAN, ANTONIA CO-FOUNDED THE ORGANIZATION FUERZA MATRIMONIAL MORE THAN A DECADE AGO IN PANORAMA CITY. ITS MISSION IS TO SERVE THE LARGER SAN FERNANDO COMMUNITY BY OFFERING FREE COUNSELING AND TO SUPPORT AND ENCOURAGE COUPLES TO STAY TOGETHER IN STRONG AND HEALTHY MARRIAGES. SHE DIED TOO SOON, NO QUESTION ABOUT THAT. SHE IS SURVIVED BY HER HUSBAND, JUAN, TWO DAUGHTERS, YADIRA MENA, AND JOANNA. AND A SON, JUAN ANTONIO. SECONDLY, I'D LIKE TO ASK THAT WE ADJOURN IN THE MEMORY OF IVO HADJIEV, LONG-TIME HISTORICAL CONSULTANT FOR THE COUNTY'S VIRGINIA ROBISON GARDENS AND LONG-TIME MAJOR DOMO, RECENTLY PASSED AWAY AT THE AGE OF 80. I HAD THE PRIVILEGE OF GETTING TO KNOW HIM A LITTLE BIT WHEN I BECAME A COUNTY SUPERVISOR. HE WAS QUITE A CHARACTER, A HIGHLY EDUCATED AND CULTURED EUROPEAN GENTLEMAN FROM AN EARLIER GENERATION AND HE WAS A POLITICAL REFUGEE FROM COMMUNIST BULGARIA WHEN HE ENCOUNTERED MRS. HARRY ROBINSON WHILE TRAVELING THROUGH THE UNITED STATES IN 1969. HE WAS OFFERED A POSITION ON HER STAFF. AFTER SHE PASSED AWAY IN 1977, IVO WAS INSTRUMENTAL IN MANAGING THE ESTATE'S TRANSITION FROM HER PRIVATE RESERVE TO ONE OF THE MOST CHERISHED AND DISTINCTIVE ASSETS IN THE LOS ANGELES COUNTY PARK SYSTEM. THERE WAS A DONATION MADE TO THE COUNTY, VIRGINIA ROBISON GARDENS, AND IT WAS QUITE SPECIAL. IVO IS SURVIVED BY HIS MANY FRIENDS AND ASSOCIATES AT THE VIRGINIA ROBINSON GARDENS. ASK THAT WE ADJOURN IN THEIR MEMORY. 

SUP. BURKE, CHAIR: WOULD YOU CALL 95? IT'S HELD FOR DISCUSSION. WE HAVE TWO PEOPLE WHO WOULD LIKE TO SPEAK ON IT. 

SUP. YAROSLAVSKY: WHY DON'T WE HEAR FROM THE PEOPLE? 

SUP. BURKE, CHAIR: ALL RIGHT. BRIAN GURWITZ. 

BRIAN GURWITZ: THANK YOU MADAM CHAIRWOMAN AND MEMBERS OF THE BOARD. MY NAME IS BRIAN GURWITZ, AND I'M REGIONAL COUNSEL FOR THE RECORDING INDUSTRY ASSOCIATION OF AMERICA. THE R.I.A.A. IS THE TRADE ASSOCIATION MADE UP OF MEMBER COMPANIES THAT CREATE, MANUFACTURER AND DISTRIBUTE APPROXIMATELY 90% OF THE LEGITIMATE SOUND RECORDINGS PRODUCED AND SOLD IN THE U.S. ON BEHALF OF R.I.A.A. AND ALL OF OUR MEMBER COMPANIES, WE WOULD LIKE TO EXPRESS OUR VERY DEEP GRATITUDE TO THIS BOARD FOR TAKING UP THIS ORDINANCE FOR CONSIDERATION. THIS BOARD HAS TAKEN A TRUE LEADERSHIP POSITION NATIONALLY IN COMBATING PIRACY OF MUSIC AND OTHER GOODS IN THIS FASHION. AND THE EFFORTS OF THIS BOARD ARE CERTAINLY WORTH IT. NOT ONLY IS PIRACY INEXTRICABLY INTERTWINED WITH VARIOUS FORMS OF ORGANIZED CRIME, BUT AS IT RELATES TO MUSIC, PIRACY IS DEVASTATING TO ONE OF THE COUNTY'S GREATEST EXPORTS AND CULTURAL SYMBOLS. ACCORDING TO A RECENT STUDY CONDUCTED BY THE L.A. ECONOMIC DEVELOPMENT CORPORATION, THE CITY OF LOS ANGELES LOST $432 MILLION IN TAX REVENUE AND LOCAL BUSINESSES WERE CHEATED OUT OF $5.2 BILLION IN LOST SALE DUE TO GLOBAL PIRACY AND COUNTERFEITING. SO, AGAIN, THANK YOU VERY MUCH ON BEHALF OF R.I.A.A. AND I'M AVAILABLE FOR ANY QUESTIONS THE BOARD MAY HAVE. 

SUP. BURKE, CHAIR: ARE THERE QUESTIONS? 

SUP. YAROSLAVSKY: WHY DON'T WE HEAR FROM MELISSA. 

SUP. BURKE, CHAIR: MELISSA PATACK. 

MELISSA PATACK: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD, MY NAME IS MELISSA PATACK. AND I'M HERE ON BEHALF OF THE MOTION PICTURE ASSOCIATION OF AMERICA AND OUR MEMBER COMPANIES, DISNEY, FOX, PARAMOUNT, SONY, UNIVERSAL, AND WARNER BROTHERS. WE SUPPORT THIS ORDINANCE, AND THANK YOU FOR YOUR LEADERSHIP IN HELPING US COMBAT PIRACY. I CAN GO INTO THE REASONS FOR IT, YOU ALL KNOW THE SCOPE OF THE PROBLEM AND THE DEPTH OF THE PROBLEM AND I'M HAPPY TO ANSWER ANY QUESTIONS. AND, AGAIN, THANK YOU FOR HELPING US TAKE ON THIS BATTLE. 

SUP. YAROSLAVSKY: MADAM CHAIR, IF I CAN JUST SAY FEW WORDS ON THIS. FIRST OF ALL, LET ME THANK BOTH OF YOU FOR NOT ONLY FOR COMING DOWN TODAY AND TESTIFYING, BUT FOR YOUR ROLE IN THE TASK FORCE IN BRINGING THIS WHOLE MATTER TO OUR COLLECTIVE ATTENTION. THIS HAS BEEN THE PRODUCT OF A JOINT TASK FORCE BETWEEN THE CITY AND THE COUNTY IN THE INDUSTRY, OF COURSE, OF HOW TO DEAL WITH THIS REALLY OUTRAGEOUS PROBLEM. A FEW FACTS ARE IN ORDER. IN 2005, MUSIC AND MOVIE COMPANIES BASED IN LOS ANGELES COUNTY LOST AN ESTIMATED $5.2 BILLION AS A RESULT OF THE SALE OF COUNTERFEIT COMPACT DISKS AND DVDS. THE BLACK MARKET FOR THESE GOODS DIVERTED $2 BILLION FROM THE LEGITIMATE RETAIL SECTOR RIGHT HERE IN LOS ANGELES. THESE CRIMES COST OUR COUNTY ABOUT 106,000 JOBS AND AT LEAST $483 MILLION IN STATE AND LOCAL TAX REVENUE. SO THIS IS NOT A SMALL PROBLEM. IT'S A BIG PROBLEM AND IT HAS BIG ECONOMIC IMPACTS, ESPECIALLY HERE IN SOUTHERN CALIFORNIA. THE SALE OF COUNTERFEIT GOODS, AS WAS INDICATED BY THE PUBLIC TESTIMONY, THE SALE OF PUBLIC GOODS ON STREET CORNERS AND AT SWAP MEETS IS INCREASINGLY CONTROLLED BY ORGANIZED CRIMINALS AND HAS THEREFORE BECOME A GATEWAY TO CRIMINAL ACTIVITY FOR YOUNG PEOPLE AND IT RESULTS IN VIOLENCE, DRUG DEALING AND OTHER SOCIAL PROBLEMS AND CRIMINAL PROBLEMS. IN JULY OF LAST YEAR, I INTRODUCED A MOTION DIRECTING THE COUNTY TO CREATE A TASK FORCE OF COUNTY DEPARTMENTS THAT WOULD EVALUATE OUR ABILITY TO COMBAT THE PROBLEM OF PIRACY AND COUNTERFEIT GOODS. THE MOTION INCLUDED LANGUAGE THAT ASKED THE COUNTY STAFF TO LOOK TO NEW YORK AS A MODEL OF A JURISDICTION THAT HAD SUCCESSFULLY FOUGHT PIRACY AND AGGRESSIVELY FOUGHT IT. THE CITY HAS BEEN ENGAGED IN A SIMILAR EFFORT. WE'VE BEEN WORKING TOGETHER WITH THE CITY OF LOS ANGELES ON THAT EFFORT. OUR ORDINANCE, THE ONE THAT'S BEFORE US TODAY, IS MODELED AFTER THE SUCCESSFUL NEW YORK STATUTES, AND IT WORKS WITHIN THE LIMITS OF EXISTING STATE LAW. IT SETS TOUGH FINANCIAL PENALTIES FOR POSSESSING, SELLING OR MANUFACTURING COUNTERFEIT OR PIRATED GOODS. IT ALLOWS THE DISTRICT ATTORNEY OR THE COUNTY COUNSEL TO ASK A JUDGE TO CLOSE DOWN A PROPERTY WHERE THIS KIND OF ILLEGAL ACTIVITY IS OCCURRING. AND IT ALLOWS THE DISTRICT ATTORNEY OR COUNTY COUNSEL TO GET A RESTRAINING ORDER AGAINST PEOPLE WHO ENGAGE IN THESE KINDS OF ACTIVITIES. GOING FORWARD FROM HERE, THE DISTRICT ATTORNEY HAS DRAFTED STATE LEGISLATION THAT WOULD EXPAND THESE PRINCIPLES STATEWIDE. THE BOARD OF SUPERVISORS SHOULD WORK WITH THE D.A. TO ENCOURAGE THE STATE LEGISLATURE TO TAKE UP THIS FIGHT. WE SHOULD CONTINUE TO WORK WITH THE SHERIFF AND THE DISTRICT ATTORNEY AND OTHER DEPARTMENTS TO CONTINUE IDENTIFYING PROBLEM LOCATIONS AND PUT THE NEW TOOLS PROVIDED BY THIS ORDINANCE INTO EFFECT. THE SOONER THE BETTER. AND CONTINUE TO WORK WITH OUR INDUSTRY PARTNERS AND FRIENDS IN THE CITY WHO EVALUATE THE EFFECTIVENESS OF THIS ORDINANCE AND FIND NEW WAYS COMBAT THIS PROBLEM. I WANT TO THANK THE SHERIFF, SHERIFF'S DEPARTMENT, THE DISTRICT ATTORNEY AND HIS DEPARTMENT, THE COUNTY COUNSEL, ESPECIALLY FOR HELPING DRAFT THIS. AND THE CHIEF EXECUTIVE OFFICER WHO PLAYED A CRITICAL ROLE IN THE DRAFTING OF THIS ORDINANCE. THE MOTION PICTURE ASSOCIATION, THE RECORDING INDUSTRY ASSOCIATION, OAKLEY, ROLEX, AND OTHER INDUSTRY PARTNERS HAVE OFFERED EXPERTISE AND SHARED EXAMPLES OF BEST MANAGEMENT PRACTICES FROM AROUND THE COUNTRY AND THEY'VE BEEN TO THE EXTENT PRACTICABLE, INCORPORATED INTO THIS ORDINANCE. I WANT TO ACKNOWLEDGE SINGULAR EFFORTS OF COUNCILMAN WENDY GREUEL OF CITY OF LOS ANGELES AND OTHER CITY LEADERS WHO HAVE ALSO BEEN FIGHTING TO ADDRESS THIS ISSUE AT THE CITY LEVEL AND TO BRING ATTENTION TO THIS ISSUE. COUNCILMAN GREUEL IS WORKING ON HAVING THE CITY ADOPT AN ORDINANCE SIMILAR TO THE ONE WE ARE ABOUT TO ADOPT THAT WOULD EXPAND OUR REGIONAL ABILITY TO FIGHT THE COUNTERFEITING PROBLEM. AND I THINK IT'S CRITICAL THAT THE CITY AND THE COUNTY WORK TOGETHER ON THIS, AND HAVE A SEAMLESS ENFORCEMENT MECHANISM. SO I THINK THIS IS A REALLY IMPORTANT DAY FOR US. AND I AM FAMILIAR SOMEWHAT WITH THE NEW YORK EXPERIENCE AND IT'S BEEN WELL DOCUMENTED IN THE NEWS AND IN SPECIAL PROGRAMS. THEY ARE RUTHLESS AND RELENTLESS ABOUT THIS BECAUSE, AT THE END OF THE DAY, THESE COUNTERFEITERS ARE STEALING OTHER PEOPLE'S LABOR. THEY'RE STEALING OTHER PEOPLE'S CREATIVE AND INTELLECTUAL RIGHTS AND PROPERTY. AND IT'S NO DIFFERENT THAN IF YOU WALK INTO A STORE AND STEAL A BAG OF POTATO CHIPS OR ROB A BANK. WHEN YOU TAKE SOMEBODY'S CREATIVE PROPERTY AND FORGE IT AND THEN SELL IT ON THE MARKETPLACE, IT DIMINISHES THE VALUE OF THE APPROPRIATE INDIVIDUAL'S PROPERTY VALUE, AND ASIDE FROM WHICH, IT'S JUST PLAIN MORALLY WRONG. SO THIS IS A TOOL THAT WE'RE GOING TO USE TO ENFORCE WHAT'S MORALLY RIGHT AND WHAT'S LEGALLY RIGHT. THE COUNTY COUNSEL HAS MADE SOME TECHNICAL AMENDMENTS, SO ANYBODY WANTS TO GO THROUGH THEM, THEY CAN. BUT THEY'RE ATTACHED TO THE REPORT, I BELIEVE, AND THE ORDINANCE AND I WOULD MOVE THIS ITEM WITH THE COUNTY COUNSEL'S AMENDMENTS. 

SUP. BURKE, CHAIR: WE'LL NOW HAVE A READING OF THE TITLE. 

CLERK SACHI HAMAI: THANK YOU. MADAM CHAIR, MEMBERS OF THE BOARD. THIS IS JUST TO READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE ADDING CHAPTER 13.90 TO TITLE 13, PUBLIC PEACE, MORALS, AND WELFARE OF THE LOS ANGELES COUNTY CODE TO ESTABLISH THE COUNTY'S COUNTERFEIT GOODS NUISANCE ABATEMENT LAW TO ADDRESS PROBLEMS ASSOCIATED WITH PROPERTIES USED FOR THE MANUFACTURER, DISTRIBUTION AND SALE OF COUNTERFEIT GOODS IN THE UNINCORPORATED AREAS OF THE COUNTY OF LOS ANGELES. 

SUP. BURKE, CHAIR: IT'S MOVED BY YAROSLAVSKY, SECONDED BY ANTONOVICH. 

SUP. YAROSLAVSKY: WITH THE COUNTY COUNSEL'S AMENDMENTS. 

SUP. BURKE, CHAIR: WITH THE COUNTY COUNSEL'S AMENDMENTS. WITHOUT OBJECTION, SO ORDERED. THANK YOU VERY MUCH. 

SPEAKER: THANK YOU VERY MUCH. 

SUP. YAROSLAVSKY: THANK YOU TO BOTH OF YOU. 

SUP. BURKE, CHAIR: OF COURSE THE COUNTY LOSES MONEY, TOO, WHEN WE HAVE THESE COUNTERFEITERS. SUPERVISOR? 

SUP. YAROSLAVSKY: I THINK I HAVE -- HAVE WE DONE ALL THE PUBLIC ITEMS? 

SUP. BURKE, CHAIR: YES. 

SUP. YAROSLAVSKY: HAVE WE DONE THE LANDFILL ITEM YET? 

SUP. BURKE, CHAIR: YES. DID YOU HAVE A COMMENT ON IT? 

SUP. YAROSLAVSKY: NO, NO, I JUST WANTED TO MAKE SURE WE... I WANTED TO PLAY A ROLE IN THIS MEETING AND I WAS LOOKING FORWARD TO CALLING ONE UP. [ LIGHT LAUGHTER ] 

SUP. YAROSLAVSKY: ALL RIGHT. I'M DONE. 

SUP. BURKE, CHAIR: I DON'T MEAN TO JUST PUSH EVERYTHING THROUGH. SUPERVISOR KNABE FOR YOUR ADJOURNMENTS. 

SUP. KNABE: ARE WE LIVE? 

SUP. BURKE, CHAIR: YES. 

SUP. YAROSLAVSKY: I DON'T KNOW. 

SUP. KNABE: FIRST OF ALL, I MOVE TODAY THAT WHEN WE ADJOURN IN MEMORY OF LORRAINE HOLMES, RESIDENT OF GREATER SOUTH BAY AREA FOR 48 YEARS. SHE PASSED AWAY ON APRIL 23RD AT THE TORRANCE MEMORIAL HOSPITAL. SHE WAS 90 YEARS OLD. MISS HOLMES RETIRED FROM HUGHES AIRCRAFT AND AFTER RETIREMENT BECAME A VERY ACTIVE, QUIET, GENTLE VOLUNTEER WHO READ TO THE BLIND, TAUGHT THE ILLITERATE TO READ AND ENRICHED THE LIVES OF MANY. HER SPIRIT OF GIVING AND HELPING WAS CONSISTENT WITH HER STRONG CHRISTIAN FAITH AND HER UPBRINGING DURING THE DIFFICULT YEARS OF THE GREAT DEPRESSION. LORRAINE IS SURVIVED BY HER ONLY SON, BOB HOLMES, FORMER MAYOR OF MANHATTAN BEACH AND A GOOD FRIEND. THOUGHTS AND PRAYERS TO BOB. ALSO WE ADJOURN IN THE MEMORY OF J. KIMBALL WALKER. HE WAS A THREE-TERM MAYOR OF BELLFLOWER, PASSED AWAY ON APRIL 17TH AT THE AGE OF 83. HE WAS A NAVY LIEUTENANT DURING WORLD WAR II, RECEIVED HIS LAW DEGREE FROM THE UNIVERSITY OF WYOMING, WORKED FOR THE JUSTICE DEPARTMENT IN SAN FRANCISCO AND LOS ANGELES, STARTED A PRACTICE IN BELLFLOWER. THEN IN 1962, TURNED TO PUBLIC OFFICE AND SERVED THREE TERMS AS COUNCILMAN AND MAYOR. HE AND HIS WIFE, EMILY, MADE CITY HISTORY WHEN THEY BECAME THE FIRST HUSBAND AND WIFE PAIR TO HAVE SERVED AS MAYORS. IN 1976, HE WAS APPOINTED TO THE BELLFLOWER COURTHOUSE AND WAS A SUPERVISING JUDGE IN NORWALK WHEN HE WAS ELEVATED TO THE LOS ANGELES SUPERIOR COURT IN 1980. HE RETIRED IN 1992 AND MOVED TO BISHOP TO BE CLOSER TO HIS DAUGHTER. KIM IS SURVIVED BY HIS WIFE OF 61 YEARS; AND A SON, BRADLEY; DAUGHTERS, JANICE, KIMBERLEE, AND TERRY; AND THREE GRANDDAUGHTERS. 

SUP. BURKE, CHAIR: SO ORDERED. ALL MEMBERS. 

SUP. KNABE: OKAY. ALSO THAT WE ADJOURN IN THE MEMORY OF CHRISTOPHER WOOTTON, A 21-YEAR-OLD FROM BELLFLOWER. MANY OF YOU HAVE PROBABLY READ ABOUT THIS IN THE PAPER THE LAST A COUPLE OF DAYS. HE WAS A SENIOR AT U.C. BERKELEY AND WAS FATALLY STABBED THIS PAST SATURDAY NIGHT. HE ATTENDED STEVE [STEPHEN] FOSTER ELEMENTARY AND MAYFAIR MIDDLE AND HIGH SCHOOL, GRADUATED IN 2004. HE WAS TO HAVE GRADUATED THIS MONTH AND WAS GOING ON FOR HIS MASTER'S DEGREE IN NUCLEAR ENGINEERING. HE WAS A VERY NICE YOUNG MAN, HE'LL BE SORELY MISSED BY HIS FAMILY AND FRIENDS AND A REAL TRAGEDY. SURVIVED BY HIS FATHER, JAMES, BROTHER JOSH AND GRANDMOTHER SHARON. ALSO THAT WE ADJOURN IN MEMORY OF WILLIAM WILLIAMSON, A RESIDENT OF REDONDO BEACH WHO PASSED AWAY ON APRIL 10TH. AGAIN, HE WAS ONLY 16 YEARS OLD, ATTENDED REDONDO BEACH HIGH SCHOOL. HE WAS A MEMBER OF THE REDONDO BEACH HIGH LA CROSSE TEAM AND ICE CLUB HOCKEY TEAM, BIG FAN OF THE KINGS. HE WAS VERY INVOLVED WORKING WITH THE PANCREATIC CANCER ACTION NETWORK. HE IS SURVIVED BY HIS PARENTS, SILVIA AND BILL; BROTHERS, NICKOLAS, JOSHUA; AND SISTER, KRISTINA. ALSO WE ADJOURN IN MEMORY OF HUMBOLDT COUNTY SUPERVISOR ROGER RODONI. HE PASSED AWAY IN A CAR COLLISION ON HIS WAY TO A COMMUNITY MEETING. HE, LAST 11 YEARS, WAS PROUDLY SERVING THE PEOPLE OF HUMBOLDT COUNTY. HE WAS MY COLLEAGUE ON C.S.A.C. AND WILL BE SORELY MISSED. HE IS SURVIVED BY HIS WIFE, JOHANNA; SONS, RUSSELL, RONAN, AND RONALD; DAUGHTER, MONICA, AND FIVE GRANDCHILDREN. ALSO THAT WE ADJOURN IN MEMORY OF EUGENE KELLOGG, LIFETIME RESIDENT OF SAN PEDRO WHO PASSED AWAY AT THE AGE OF 90. HE WORKED HIS ENTIRE LIFE IN THE LUMBER INDUSTRY AND JOINED HIS FATHER AND TWO BROTHERS AT KELLOGG LUMBER AND SUPPLY COMPANY, IN LOMITA. HE WAS VERY ACTIVE HIN HIS COMMUNITY, WAS A MEMBER OF THE LA RAMBLA PRESBYTERIAN CHURCH IN SAN PEDRO. HE IS SURVIVED BY HIS FOUR CHILDREN, DON, JUDY, RICHARD AND JOHN; 15 GRANDCHILDREN, AND 16 GREAT GRANDCHILDREN. ALSO THAT WE ADJOURN IN THE MEMORY OF CHARLES HILLINGER, A PENINSULA RESIDENT AND FORMER "L.A. TIMES" COLUMNIST WHO PASSED AWAY RECENTLY. HE WAS OF 82. HE IS SURVIVED BY HIS WIFE OF 59 YEARS, ARLIENE; DAUGHTER, TORI; SON, BRAD; AND FOUR GRANDAUGHTERS. ALSO THAT WE ADJOURN IN THE MEMORY OF WILLIAM ROBERT WYATT, LONG-TIME LAKEWOOD RESIDENT WHO PASSED AWAY AT THE AGE OF 85. HE GRADUATED FROM U.S.C. WITH A DEGREE OF CIVIL ENGINEERING, SERVED IN THE AIR FORCE DURING WORLD WAR II. HE FOUNDED WYATT AUTOMATIC PRODUCTS AND RAN THE MANUFACTURING COMPANY FOR 42 YEARS. VERY ACTIVE GOLFER AND WAS A VERY GENEROUS MAN. HE IS SURVIVED BY HIS WIFE OF 65 YEARS, ELEANOR; DAUGHTERS, DIAN; SON WILLIAM; FOUR GRANDCHILDREN, FIVE GREAT GRANDCHILDREN. FINALLY, DAVID SHEPHERD WHO PASSED AWAY, A RESIDENT OF HARBOR CITY. HE JOINED THE CALIFORNIA NATIONAL GUARD IN 1940 AND SOON FOUND HIMSELF AS A SERGEANT IN CHARGE OF ANTI-AIRCRAFT GUN ON DECEMBER 7TH, 1941. HE SERVED THROUGHOUT THE PACIFIC THEATRE FOR THE DURATION OF WORLD WAR II. AFTER THE WAR, HE JOINED THE LOS ANGELES COUNTY FIRE DEPARTMENT, WHERE HE SERVED 30 YEARS. WORKED AS A FIRE FIGHTER, ENGINEER, FIRE PREVENTION OFFICER. HE RETIRED IN 1975. HE WORKED AS A FIRE SAFETY EXPERT ON MANY MOVIES AND TELEVISION SETS FOR ALL THE MAJOR STUDIOS, LIFELONG MEMBER OF THE REDONDO BEACH ELK'S LODGE, AND WAS VOTED ELK OF THE YEAR IN 1978. HE IS SURVIVED BY HIS TWO SONS, RON AND DOUGLAS, SIX GRANDCHILDREN, AND FOUR GREAT GRANDCHILDREN. MADAM CHAIR, THOSE ARE MY ADJOURNMENTS. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. KNABE: I HELD ITEMS 1-D AND 2-H. THE QUESTION I HAD PROBABLY FOR THE C.E.O. AND FOR MAYBE -- YOU KNOW, WE'VE HAD SOME ISSUES IN AUDITS WITH THIS DEPARTMENT OVER THE LAST SEVERAL YEARS, AND I JUST WANT, YOU KNOW, SOME COMMENT THAT WHEN WE HIRE THESE FOLKS, THEY WERE THERE DURING THAT PARTICULAR TIME. AND I JUST WANT TO MAKE SURE THAT THEY WEREN'T PART OF THE PROBLEM, SO I DON'T KNOW WHO CAN ANSWER THAT, BILL OR CARLOS. 

CARLOS JACKSON: SUPERVISOR, THIS IS A NEW FIRM FOR US IN TERMS TO DO THE FINANCIAL AUDITS. THEY WERE NOT THERE DURING THE YEARS OF '04/'05, '05/06. 

SUP. BURKE, CHAIR: BOTH CONTRACTS? 

CARLOS JACKSON: YES. 

SUP. KNABE: OKAY. THANK YOU WITH. WITH THAT, I'LL MOVE THE ITEMS. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. I'D LIKE TO SAY CARLOS, IT'S GOOD NEWS THAT WE RECEIVED THAT ALL OF THOSE ISSUES HAVE BEEN RESOLVED AS FAR AS THE SECTION 8. CONGRATULATIONS TO YOU. WITHOUT OBJECTION, ITEM 1-D IS APPROVED. 

SUP. KNABE: I WASN'T HOLDING ANYTHING ELSE. 

SUP. BURKE, CHAIR: HMM? 

SUP. KNABE: I WASN'T HOLDING ANYTHING ELSE. 

SUP. BURKE, CHAIR: AND WITHOUT OBJECTION, 2-H IS MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. SUPERVISOR ANTONOVICH. DID YOU HAVE ANY ADJOURNMENTS, SUPERVISOR MOLINA? SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: YES. I WOULD LIKE TO MAKE THE FOLLOWING ADJOURNMENTS. ANA BUNTICH, WHO PASSED AWAY AT THE AGE OF 95. SHE HAD BEEN BORN IN CROATIA AND IMMIGRATED TO LOS ANGELES COUNTY IN 1958, WHERE SHE MADE HER HOME WITH HER LATE HUSBAND, JOHN, FOR HALF A CENTURY. SHE IS SURVIVED BY FIVE OF HER SEVEN CHILDREN, 14 GRANDCHILDREN, 36 GREAT GRANDCHILDREN, AND TWO GREAT, GREAT GRANDCHILDREN. SHE WAS A WONDERFUL LADY. AND I HAD THE OPPORTUNITY TO KNOW HER. ROBERT CHAVEZ, WHO WAS THE SON OF OUR FORMER PRESIDING JUDGE AND GOOD FRIEND, VICTOR CHAVEZ, AND BROTHER OF APPELLATE COURT JUSTICE, VICTORIA CHAVEZ, WHO WAS AN ATTORNEY. HE WAS A VERY OUTSTANDING BARRISTER, HE ADVOCATED FOR QUALITY SERVICE AT NURSING HOMES, HE WAS A STAND OUT ATHLETE AT U.S.C., WHERE HE RECEIVED HIS BACHELOR AND LAW DEGREES AND ALL AMERICAN AND N.C.A.A. CHAMPION VOLLEYBALL PLAYER FOR THE UNIVERSITY. HE DIED OF A HEART ATTACK AT THE AGE OF 46, LEAVING HIS WIFE, CHRISTINA, AND HIS THREE CHILDREN AND HIS FATHER AND SISTER. RICHARD RALPH CRIMENI, A LONG-TIME RESIDENT OF THE OF BURBANK, QUITE INVOLVED IN ALL OF THE VARIOUS COMMUNITY PROGRAMS. HE WAS PREVIOUSLY THE OWNER OF THE LINCOLN-MERCURY AGENCY AND LATER BURBANK TOYOTA. AND ALSO APPEARED IN MANY TELEVISION PRODUCTIONS, LIKE "BAYWATCH," "BEVERLY HILLS 90210," "JAKE AND FAT MAN," AND WAS A VETERAN OF THE UNITED STATES NAVY. JAMES "JERRY" DOMINE, WHO WAS AN AVID SUPPORTER OF THE SAN FERNANDO VALLEY SYMPHONY AND WORKED AT -- FORMERLY AT NORTH AMERICAN AVIATION, TAUGHT BUSINESS PSYCHOLOGY AT PIERCE COLLEGE, MISSION HILLS COLLEGE AND THE UNIVERSITY OF REDLANDS. STEPHAN MILLER, WHO WAS THE HUSBAND OF SENIOR DEPUTY COUNTY COUNSEL ELIZABETH MILLER. YOU READ ABOUT THE TRAGIC ACCIDENT THAT OCCURRED. HE WAS TRAINING THE GRIZZLY BEAR AT THE BIG BEAR TRAINING FACILITY WHEN THE BEAR SUDDENLY ATTACKED HIM AND KILLED HIM. HE TRAINED TIGERS, LIONS, LEOPARDS AND COUGARS WHICH HE HAD TRAINED. HE WAS A RESIDENT OF THE SAN CLARITA VALLEY, CANYON COUNTRY AND HE LEAVES HIS WIFE, ELIZABETH, AND A SON AND DAUGHTER. AND HE PASSED AWAY, TRAGICALLY, AT THE AGE OF 39. MARTIN ANTHONY MATICH, WHO OWNED MATICH CORPORATION FOR OVER 60 YEARS. HE WAS QUITE ACTIVE IN THE RELIGIOUS AND CIVIC ORGANIZATIONS THROUGHOUT THE INLAND EMPIRE. AS THE CORPORATE CHAIRMAN OF THE MATICH CORPORATION, HE OVERSAW HUNDREDS OF HIGHWAYS, AIRPORTS, FLOOD CONTROL, MILITARY CONSTRUCTION PROJECTS THROUGHOUT OUR STATE. HE HAD RECEIVED MANY AWARDS, INCLUDING THE ENGINEERING HONOR AWARD FROM NOTRE DAME UNIVERSITY. HE WAS A CITIZEN OF THE YEAR LIFETIME ACHIEVEMENT RECOGNITION FROM GOVERNOR SCHWARZENEGGER. HE HAD AN HONORARY LAW DEGREE FROM VANGUARD UNIVERSITY AND WAS ACTIVE IN OUR LADY OF ROSARY CATHEDRAL, KNIGHTS OF EQUESTRIAN THE ORDER OF HOLY SEPULCHER AND THE KNIGHTS OF COLUMBUS. GOOD FRIEND AND GREAT COMMUNITY LEADER. WILLIAM EUGENE MULVIHILL GREW UP AND ATTENDED SCHOOLS IN GLENDALE. HE LEFT MILITARY SERVICE TO GO BACK TO THE UNIVERSITY, WHERE HE OBTAINED HIS TEACHING CREDENTIAL AND HE LAUNCHED A SECOND CAREER AFTER THE MILITARY BY TEACHING NOT ONLY IN AUSTRALIA BUT IN L.A. CITY UNIFIED SCHOOL DISTRICT. HE WAS AN ACTIVE MEMBER OF THE HOLY FAMILY PARISH IN GLENDALE AND ALSO INVOLVED WITH KNIGHTS OF COLUMBUS AND AMERICAN LEGION GLENDALE POST 127. NORMA JEAN SEIFERT, LONG-TIME RESIDENT OF GLENDALE, MEMBER OF THE SALEM LUTHERAN, WHERE SHE WAS A SUNDAY SCHOOLTEACHER, A MEMBER OF THE WOMEN'S CLUB AND COORDINATOR OF WEDDINGS, AND HELPED RAISING FUNDS FOR THE HOMELESS WITH A GROUP FROM THE CHURCH. SHE WAS ALSO A MEMBER OF THE P.T.A., CAMPFIRE GIRLS, AND WORKED WITH THE GLENDALE CITY COUNCIL. EMIL ["BUZZIE"] BAVASI, WHO WAS THE FORMER GENERAL MANAGER OF THE DODGERS THROUGHOUT THE TRANSITION FROM BROOKLYN TO LOS ANGELES. IN 1951 HE WAS PROMOTED TO THE POSITION OF DODGER GENERAL MANAGER. THEY WON EIGHT NATIONAL LEAGUE PENNANTS UNDER HIS LEADERSHIP. AFTER THE TEAM WON THE WORLD SERIES IN 1959 IN THEIR ONLY SECOND YEAR IN LOS ANGELES COUNTY, SPORTING NEWS NAMED HIM THE MAJOR LEAGUE EXECUTIVE OF THE YEAR. IN 1968, HE RESIGNED FROM THE DODGERS TO BECOME PRESIDENT OF THE SAN DIEGO PADRES UNTIL 1977. THEN IN 1978, HE BECAME GENERAL MANAGER OF THE CALIFORNIA ANGELS AND NOW THE LOS ANGELES ANGELS OF ANAHEIM. HE PASSED AWAY AT THE AGE OF 92. ALL MEMBERS. RICHARD GRIFFEN, A SHERIFF'S DEPUTY FOR THE PAST 29 YEARS. HIS LAST ASSIGNMENT WAS THE RECORDS BUREAU. OLIVER FULLER, LAW ENFORCEMENT TECHNICIAN OF LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. HE PASSED AWAY AT THE AGE OF 65. HIS LAST ASSIGNMENT WAS THE FACILITY SERVICES BUREAU. LOUIS SHUMACHER, A RETIRED LIEUTENANT. HE SERVED 33 YEARS WITH THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. THOSE ARE MY ADJOURNMENT MOTIONS. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. ANTONOVICH: I WOULD LIKE TO INTRODUCE A MOTION. A TRAGEDY OCCURRED IN THE ANTELOPE VALLEY AT APPROXIMATELY 11:30 P.M. LAST NIGHT ON THE 300 BLOCK OF EAST LINGARD STREET. NEIGHBORS HEARD A DOG YELPING AND THEN SAW IT RUNNING IN THE STREETS, ITS FUR ABLAZE. ONE COURAGEOUS NEIGHBOR PUT A COAT OVER THE DOG, EXTINGUISHING THE FLAMES, AND TOOK THE DOG TO THE ANIMAL SHELTER, WHERE IT'S NOW BEING TREATED FOR BURNS TO ITS LEGS AND BACK. INDIVIDUAL OR INDIVIDUALS RESPONSIBLE COULD FACE FELONY ANIMAL CRUELTY CHARGES. THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT IS SEEKING ANY INFORMATION ON THESE CASES AND REQUESTS ASSISTANCE FROM THE PUBLIC AND I WOULD LIKE TO MOVE THAT WE OFFER A $5,000 REWARD IN EXCHANGE FOR INFORMATION THAT WOULD LEAD TO THE ARREST AND CONVICTION OF SUSPECT OR SUSPECTS RESPONSIBLE FOR SETTING THIS DOG ON FIRE ON MAY 5TH ON THE 300 BLOCK OF EAST LINGARD STREET IN LANCASTER. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION. 

SUP. ANTONOVICH: THEN ON ITEM NUMBER 80, SUPERVISOR YAROSLAVSKY AND I WOULD LIKE TO MAKE THE FOLLOWING AMENDMENT THAT THE CHIEF EXECUTIVE OFFICER'S REPORT AND THE MAY 2ND, 2008 CONTAINS SEVERAL RECOMMENDATIONS TO AVOID RETROACTIVE AGREEMENTS AND ENSURE TIMELY PAYMENTS FROM THE CITY OF LOS ANGELES FOR CLEAR PROGRAM. WE WOULD MOVE THAT THE BOARD APPROVE ITEM 80 AND ADOPT THE RECOMMENDATIONS CONTAINED IN THE C.E.O.'S REPORT OF MAY 2ND, 2008. 

SUP. BURKE, CHAIR: MOVED AND SECONDED. WITHOUT OBJECTION. I'D LIKE TO JUST GET ONE THING CLARIFIED. IS THIS MOTION JUST AS TO CLEAR OR AS TO ALL OF OUR CONTRACTS WITH THE CITY OF L.A.? 

SUP. ANTONOVICH: THIS IS WITH CLEAR, BUT I HAVE NO PROBLEM MAKING IT FOR ALL CONTRACTS. I COULD MAKE IT FOR ALL CONTRACTS. 

SUP. BURKE, CHAIR: ALL CONTRACTS? ALL RIGHT. WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: AND THEN I WOULD LIKE TO INTRODUCE A MOTION. THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES RECENTLY NOTIFIED 38 CURRENTLY CONTRACTED GROUP HOME AND FOSTER FAMILY AGENCY SERVICE PROVIDERS THAT THEIR COUNTY CONTRACTS FOR PLACEMENT SERVICES WILL EXPIRE ON OCTOBER 31ST OF THIS YEAR. THE REASON FOR THIS NOTIFICATION WAS A RESULT OF THE AGENCIES NOT SUBMITTING A TIMELY RESPONSE TO THE DEPARTMENT'S ADVERTISED SOLICITATION FOR NEW SERVICES. CONSEQUENTLY, PLACEMENT TRANSITION PLANNING FOR OVER 700 CHILDREN PLACED WITH THESE FACILITIES IS NOW CURRENTLY UNDERWAY. THE OUT OF HOME PLACEMENT STABILITY OF ABUSED AND NEGLECTED CHILDREN MUST REMAIN OF UTMOST CONCERN. THESE CHILDREN EXPERIENCE SOME OF THE HIGHEST INCIDENTS OF MENTAL ILLNESS DUE TO THE OBVIOUS TRAUMAS OF ABUSE AND NEGLECT FOLLOWED BY THE LOSS OF THEIR BIOLOGICAL PARENTS AND SUBSEQUENT MULTIPLE FOSTER CARE PLACEMENTS. FURTHERMORE, THERE IS MUCH RESEARCH THAT INDICATES THE MULTIPLE PLACEMENT MOVES ARE DETRIMENTAL TO THE ACHIEVEMENT OF A CHILD'S PERMANENCY GOALS, WHETHER THROUGH REUNIFICATION, LEGAL GUARDIANSHIP, OR ADOPTIONS. OUR COUNTY MUST MAKE EVERY EFFORT TO ENSURE THAT THE FUTURE OF THESE MOST VULNERABLE CHILDREN ARE DETERMINED THROUGH STABILITY IN SAFE AND NURTURING ENVIRONMENTS. SO I WOULD MOVE THAT THE BOARD DIRECT THE C.E.O. IN CONJUNCTION WITH THE AUDITOR-CONTROLLER, COUNTY COUNSEL, D.C.F.S. AND PROBATION TO REPORT BACK IN 30 DAYS ON ITS REVIEW AND ASSESSMENTS OF THE GROUP HOME AND FOSTER FAMILY AGENCY CONTRACT SOLICITATION, INCLUDING ALL CIRCUMSTANCES UNIQUE TO THE APPLICATION OF THIS SOLICITATION PROCESS, AND DEVELOP A CORRECTIVE ACTION PLAN BASED ON FINDINGS AS NECESSARY. SO THIS IS A REPORT BACK, MADAM CHAIR. 

SUP. BURKE, CHAIR: ALL RIGHT. THAT'S MOVED BY ANTONOVICH AND SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION. SO ORDERED. 

SUP. ANTONOVICH: WE DID NUMBER 59? 

SUP. BURKE, CHAIR: YES. 

SUP. ANTONOVICH: THAT'S ALL I HAVE, MADAM CHAIR. 

SUP. BURKE, CHAIR: ALL RIGHT. NOTHING ELSE. PUBLIC COMMENT. 

SUP. YAROSLAVSKY: PUBLIC COMMENT? ON THE PREVIOUS ITEM, SUPERVISOR MOLINA ASKED, DOES ANYBODY ELSE OWE US, OR DO THEY OWE US ANY OTHER MONEY? I THINK IT WOULD BE A GOOD IDEA IF THE C.E.O. HAD ITS STAFF KIND OF SCRUB ALL AGENCIES, NOT JUST THE CITY OF L.A., JUST RUN IT THROUGH ALL YOUR STAFF PEOPLE TO SEE IF THERE ARE ANY OUTSTANDING OWED MONEYS TO US, BECAUSE I BET YOU THERE'S PLENTY, AND I'M SURE THE CITY OF L.A. IS NOT THE ONLY ONE. I'LL BET YOU WE PROBABLY OWE A FEW PEOPLE SOME MONEY, AND I THINK WE OUGHT TO HOLD OURSELVES AND OUR PARTNERS TO A HIGHER STANDARD THAN THEY'VE BEEN HELD TO. SO YOU MAY FIND A BUNCH OF DOUGH SITTING OUT THERE GOING BACK A LONG TIME. THANKS, BILL. THAT'S ALL. 

SUP. BURKE, CHAIR: ALL RIGHT. WE HAVE A NUMBER OF PEOPLE HAVE ASKED TO SPEAK, SOME OF THEM ON THE SUBJECT OF YOUR MOTION. ODELLET AQUINO. IF SHE'S NOT HERE, JUANITA ANTEPORT AND JAMES HOLT WANTED TO SPEAK IN HER PLACE. I'D LIKE TO ALSO ASK NICHOLAS KFOURI TO COME FORWARD. AND ARNOLD SACHS, WOULD YOU START DOWN? 

SPEAKER: GOOD MORNING. I WOULD LIKE TO SAY THAT ABOUT EIGHT MONTHS AGO, I WAS HERE AT THIS TABLE, PRESENTED A LETTER OF SOME GRIEVANCES THAT I HAVE WITH THE COUNTY. AND TO DATE, I STILL HAVEN'T HEARD FROM ANYBODY, AND WHEN I TRIED TO FOLLOW UP WITH THE EXECUTIVE OFFICES, THEY SAID THEY HAVE NO RECORD OF MY LETTER. SO I DON'T KNOW IF I'M BEING -- IF I'M BEING IGNORED OR TREATED AS A SECOND-DEGREE CITIZEN OR SOMETHING LIKE THAT. I'D LIKE TO KNOW. 

SUP. BURKE, CHAIR: ALL RIGHT. WE'LL ASK THEM TO LOOK TO SEE. WHAT DATE DID YOU SEND THE LETTER? 

SPEAKER: THE FIRST WEEK OF LAST SEPTEMBER. 

SUP. BURKE, CHAIR: OF LAST SEPTEMBER, OKAY. 

SPEAKER: YEAH. I WAS HERE IN PERSON. 

SUP. BURKE, CHAIR: OKAY. ALL RIGHT. WE'LL ASK THEM TO CHECK ON THE LETTER. AND THERE WILL BE SOMEONE WHO WILL -- MAYBE THEY'LL HAVE TO PROBABLY RESPOND TO YOU BY MAIL. 

SPEAKER: WHEN I CONTACTED THEM, THEY COULD NOT FIND A RECORD OF IT. 

SUP. BURKE, CHAIR: DO YOU HAVE ANOTHER COPY OF IT? 

SPEAKER: I DIDN'T BRING IT WITH ME. I SUBMITTED FIVE DIFFERENT COPIES FOR EACH SUPERVISOR. 

SUP. BURKE, CHAIR: OKAY. IF YOU DON'T MIND, IF YOU WOULD JUST SUBMIT US ANOTHER COPY. 

SPEAKER: ANOTHER COPY? 

SUP. BURKE, CHAIR: YES PLEASE 

SPEAKER: AND WHO DO I GIVE IT TO? 

SUP. BURKE, CHAIR: YOU CAN GIVE IT TO OUR EXECUTIVE OFFICER. 

SPEAKER: NOT TODAY. I HAVE TO MAKE ANOTHER PRINT. 

SUP. BURKE, CHAIR: OR YOU CAN MAIL IT TO THE EXECUTIVE OFFICE. 

SPEAKER: WHO IN THE EXECUTIVE OFFICE I CAN DEAL WITH? 

SUP. BURKE, CHAIR: OKAY. THERE'S SOMEONE OVER THERE AT THE CORNER WHO WILL TALK TO YOU ABOUT IT. 

SPEAKER: THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT, LET ME ASK, JUANITA AND JAMES HOLT, HAVE THEY LEFT, OR ODELLETE AQINO? YES. WOULD TRACEY CHAVIRA START COMING DOWN? AND SENTAYEHU SILASSIE ALSO. YES, ARNOLD SACHS. 

ARNOLD SACHS: GOOD AFTERNOON. A COUPLE ITEMS TO TALK ABOUT. ACTUALLY, I DON'T KNOW IF THIS IS UP TO DATE, BUT MAY 5TH, THE DOWNTOWN L.A. NEWS, THE GRAND AVENUE CONSTRUCTION IS PUSHED BACK. GOES ON TO DISCUSS THE FACT THAT THEY'RE HAVING TROUBLE FINDING FUNDING. THE REASON I BRING THIS UP IS BECAUSE THEY WERE -- THIS IS THE SECOND TIME THE CONSTRUCTION -- THE START OF CONSTRUCTION HAS BEEN DELAYED. AND THE FIRST TIME, IT WAS MENTIONED IN THE PAPER THAT THERE WERE SUPPOSED TO BE PENALTIES THAT WERE TO BE INITIATED IF THEY DIDN'T MEET THE CONSTRUCTION DATE THAT WAS ORIGINALLY PLANNED. NOW THE SECOND TIME THAT IT'S BEEN DELAYED, THEY GOT PLENTY OF TAX INCENTIVE AND BREAKS FROM THE COUNTY AND THE CITY, WILL THE PENALTIES BE ENFORCED BY THE COUNTY AND/OR THE CITY? OR WILL THEY ALSO BE DELAYED BECAUSE IT'S A DEEP POCKET AND YOU WOULDN'T WANT TO UPSET ANYBODY WITH THOSE DEEP POCKETS? THEN PROJECT 50, THERE WAS AN UPDATE, NOT FROM THE COUNTY BOARD OF SUPERVISORS, BUT FROM THE NEWSPAPER, THAT THEY'VE HOUSED 23 PEOPLE. CONGRATULATIONS. I'M READING FROM ANOTHER ARTICLE IN THE DOWNTOWN NEWS, THE -- SOMEBODY FROM THE LOS ANGELES COUNTY HOMELESS SERVICES AUTHORITY SAYS THAT IT TAKES AN AVERAGE OF 14 DAYS TO IDENTIFY THE VULNERABLE HOMELESS INDIVIDUALS AND CONVINCE THEM TO MOVE INTO THEIR OWN APARTMENTS WHERE THERE IS A SUITE OF SUPPORT SERVICES. THEN FURTHER IN THE ARTICLE IT SAYS SKID ROW HOUSING TRUST IS PROVIDING DOWNTOWN LOS ANGELES UNITS FOR THE 50 PEOPLE. WELL, IF THEY ONLY HAVE 23 PEOPLE THAT HAVE BEEN IDENTIFIED, THAT MEANS 27 UNITS ARE EMPTY. ARE THEY BEING PAID FOR WHILE YOU'RE WAITING TO FILL 27 PEOPLE THAT YOU CAN'T FIND IN SKID ROW THAT DESPERATELY NEED HOUSING? WHAT IS THE STATUS ON THAT? THANK YOU FOR YOUR ANSWERS ON THAT. AND THEN FINALLY, BECAUSE YOU WERE IN WASHINGTON, I DIDN'T GET TO COMMENT ON THE METRO BOARD MEETING. AND IT WAS REALLY VERY IMPRESSIVE TO SEE ALL THE MEMBERS FROM THE SAN GABRIEL VALLEY WHO WERE PART OF THE FOOTHILLS, THE GOLD LINE FOOTHILL CONSTRUCTION AUTHORITY. BUT MY QUESTION IS, WHERE WAS THE PASADENA GOLD LINE FOOTHILL, GOLD LINE CONSTRUCTION AUTHORITY MEMBERS? WHEN THE STATE TOOK -- THREATENED TO TAKE FUNDING AWAY FROM THE COUNTY AND THE CITY FROM THE TRANSPORTATION BOND ISSUE, BOTH THE CITY AND THE COUNTY SENT REPRESENTATIVES TO SACRAMENTO. YOU WOULD HAVE THOUGHT THAT HERE IS AN OPPORTUNITY FOR BOTH THOSE CONSTRUCTION AUTHORITIES, EVEN THOUGH THEY COVER THE SAME AREA, TO COME BEFORE METRO AND BE HEARD AND RAISE THEIR VOICES TOGETHER TO SAY WE WANT OUR RAIL LINE BUILT. BUT NOBODY FROM THE PASADENA GOLD LINE CONSTRUCTION AUTHORITY SHOWED UP. IMAGINE THAT. IT'S JUST SHOCKING. HOW THEY MISSED THAT OPPORTUNITY. NO WONDER THEY'RE STILL NOT GETTING BUILT. THANK YOU FOR YOUR TIME AND YOUR ANSWERS AND THANK YOU FOR LETTING ME SPEAK OVER. 

SUP. BURKE, CHAIR: SENTAYEHU SILASSIE? MRS. LELA DUFFIE, TRACEY CHAVIRA. ARE ANY OF THEM... WOULD YOU PLEASE COME FORWARD? 

TRACEY CHAVIRA: HI. TRACEY CHAVIRA FROM CENTRAL CITY ASSOCIATION. I'M HERE TO VOICE C.C.A.'S OPPOSITION TO THE OPENING OF A COMPREHENSIVE HOMELESSNESS SERVICES FACILITY ON THE GROUND FLOOR OF 5TH AND MAIN STREET. C.C.A. MEMBERS WERE GIVEN A PRESENTATION BY THE COUNTY ON PROJECT 50 IN JANUARY. WE WERE VERY SUPPORTIVE OF THE PROGRAM AS IT WAS EXPLAINED. WE BELIEVE THAT PROJECT 50, THAT THE SITE IS IN AN INAPPROPRIATE LOCATION FOR THE PROPOSED FACILITY. IT IS SURROUNDED BY EXISTING AND EMERGING RESIDENTIAL AND COMMERCIAL COMPONENTS AND WE ARE NOT ALONE. COUNCIL MEMBER JAN PERRY IS ALSO ADAMANTLY OPPOSED. C.C.A. PROMOTE PROJECTS THAT PROMOTE GOOD TRAFFIC AND POSITIVE PEDESTRIAN ACTIVITY, ESPECIALLY IN THE EVENING HOURS, AND INCREASED LIGHTING AND SECURITY WHICH MEANS ENHANCED PUBLIC SAFETY IN THIS BURGEONING NEIGHBORHOOD. THE SITE IS RIPE FOR COMMUNITY AMENITIES AND GROUND FLOOR ACTIVITY. AT A MEETING HELD BY SUPERVISOR YAROSLAVSKY IN APRIL, WE VOICED OUR STRONG OPPOSITION TO THIS SITE AND WERE TOLD THAT THE COUNTY WOULD WORK WITH US AS THE SITE WAS NOT SET IN STONE. WE ARE A MAJOR STAKEHOLDER IN DOWNTOWN AND WE WERE NOT CONSULTED IN THE SELECTION OF THIS SITE. WE RESPECTFULLY REQUEST THAT YOU STOP CONSTRUCTION ON THIS SITE AND CONSIDER ALTERNATE LOCATIONS. WE ARE CONFIDENT THAT IF WE WORK TOGETHER, WE CAN COME TO AN EXPEDITIOUS SOLUTION. THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU VERY MUCH. THERE'S SOMEONE HERE FROM THE OFFICE WORKING ON THAT. 

SUP. YAROSLAVSKY: C.E.O. IS NOT HERE. THIS IS NOT OUR PROPERTY. IT'S OUR PROGRAM. IT'S A SHELTER PARTNERSHIP. SKID ROW HOUSING CORPORATION, I'M SORRY, THAT IS LEASING -- THAT OWNS, I BELIEVE IT OWNS THIS BUILDING AND HAS A LONG-TERM LEASE, AND THEY ARE REQUIRED TO USE IT FOR THESE TYPES OF PURPOSES. I THINK THEY ARE TRYING TO WORK WITH THE CENTRAL CITY ASSOCIATION AND ARE OTHER INTERESTED PARTIES. IT WAS NOT THE COUNTY'S DECISION AND IT IS NOT THE COUNTY'S DECISION. I KNOW THE C.E.O.'S OFFICE IS AWARE OF THIS AND I'VE ENCOURAGED THE SKID ROW HOUSING CORPORATION FOLKS TO WORK WITH THEM. BUT I HAVE TO TELL YOU, IF THERE WAS AS MUCH ENERGY PUT TO SOLVING HOMELESSNESS AS THERE IS IN DEALING WITH THIS ONE 2000 SQUARE FOOT STOREFRONT, WE'D BE A LONG WAY -- I JUST CAN'T BELIEVE THAT PEOPLE CAN'T SIT DOWN AND WORK THIS OUT. BUT ANYWAY, IT'S NOT THE COUNTY'S DECISION, IT WAS NOT THE COUNTY'S DECISION. 

SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU. YES, PLEASE STATE YOUR NAME. 

LELA DUFFIE: GOOD MORNING. MY NAME IS LELA DUFFIE, I'M AN X-RAY TECHNICIAN. AND I'VE BEEN BLACK BALLED FROM WORK FROM MARTIN LUTHER KING FOR ABOUT 19 YEARS BY THE X-RAY SUPERVISOR. I'M NOT GOING TO CALL OUT HIS NAME, BUT I DO KNOW HE'S A HOMOSEXUAL. HE BROUGHT A MAN IN FROM PRISON IN 1988. HE GAVE MY JOB TITLE AND MY HUSBAND'S NAME. HE PUT HIM ON THE PAYROLL. HE DIDN'T DO ANY WORK. HE ALWAYS -- HE WAS GAVE HIM A BEEPER AND A CAR. AND HE'S IN PASADENA LIVING UNDER MY HUSBAND'S NAME. I SEEN IT IN THE PHONE BOOK, OKAY? BUT NOBODY WILL HIRE ME BECAUSE OF THE SUPERVISOR'S REMARKS. HE CALLED ME CRAZY, HE RECOMMEND I GO TO THE MENTAL HOSPITAL, HE HAD MY ESTRANGED FAMILY IN HIS OFFICE MANY DAYS WHEN I RETURNED TO WORK AND HE TOLD ME TO GO HOME TO MY MOTHER IN 1988. AND HE WROTE ME UP FOR MANY THINGS, FOR MOLESTING TWO CHILDREN, 5 AND 14. THAT'S A SERIOUS AFFAIR. THAT'S A SERIOUS CHARGE, OKAY? AND I DIDN'T DO ANYTHING BUT CAME TO WORK CLEAN AND DID MY WORK. OKAY? I TRANSFERRED HERE FROM WASHINGTON UNIVERSITY IN THE YEAR OF '81. AND I STARTED WORKING AT MARTIN LUTHER KING IN 1984. I HAVE JOB RIGHTS WITH THE CIVIL SERVICE AS A MILITARY WIDOW UNTIL I DIE, OKAY? UNTIL I REMARRY. HE CANCELLED ALL THAT HE WAS JEALOUS OF THE MILITARY CHECK I WAS GETTING. A STIPEND FOR HIS DEATH. HE SAID I WAS SUPPOSED TO TELL HIM AND HE COULD DEDUCT IT FROM MY PAYCHECK. HE WAS JEALOUS BECAUSE I WAS GOING TO MILITARY BASE SHOPPING AND GETTING DISCOUNTS. I HAD A STICKER IN MY WINDOW THAT SAID DEPARTMENT OF DEFENSE. AND THE REST OF THE CO-WORKERS SAID THEY WANT TO BE LIKE ME. HE SAID "I CAN REDUCE HER TO NOTHING. SHE'S NOT NOTHING. SHE THINGS SHE'S BETTER THAN WE ARE. I CAN HAVE HER CRAWLING AROUND ON THE GROUND AND EATING S-H-I-T OF THE GROUND WITH A TOOTHPICK, OKAY? I HAVEN'T GOT NO RESPECT SINCE I WAS EVICTED FROM EAGLE ROCK APARTMENT IN 19-- 2003. I GOT A CALL FROM DOWN HERE, SAY I NEED TO GO IN A MENTAL HOSPITAL FOR MY OWN GOOD. OKAY? THEY WENT UP ON THE RENT $200. I HAD A JOB WHEN I MOVED IN. YOU CANNOT PAY YOUR BILLS WITHOUT A JOB. THE FACT THAT I GET THIS LITTLE CHECK, THEY'RE ALL UPSET AND TRYING TO STEAL IT. SO NOW I'M IN A FLOPHOUSE NOW. AND SHE TELLS ME ON THE 7TH OF MARCH TO GET OUT OF THE HOUSE, BECAUSE SHE WANTS 50 MORE DOLLARS. SHE WANTS ALL MY CHECK, OKAY? I GET THIS CHECK OR HE'LL HAVE THE SOLDIER. AND I WANT TO GET AWAY FROM HER. I TRIED TO GET BACK IN. SHE BLOCKED ME, SHE HAD A KNIFE IN HER HAND, AND SHE TOLD ME-- AND KNOCKED ME DOWN TWICE AND GET OUT, YOU JUST WALK OUT OF HERE WITH THE CLOTHES ON YOUR BACK. EVERYTHING YOU HAVE HERE IS MINE. IT'S A LITTLE ROOM WITH A LOT OF CLOTHES AND EIGHT SUITCASES. SHE WANTS ALL THAT, SO I HAD TO CALL THE POLICE TO GET BACK IN. JUST THE OTHER NIGHT, SHE TOLD ME TO GET OUT AND WALK OUT WITH THE CLOTHES ON MY BACK. I WANTED TO GET AWAY, BUT SHE'S GETTING MONEY FROM THE STATE MENTAL HOSPITAL. OKAY? UNDER THE TABLE. AND I'M TIRED. I WROTE YOU TWO MONTHS AGO AND NEVER GOT AN ANSWER. THIS IS THE 5TH TIME. I'VE WROTE SO MANY PEOPLE IN WASHINGTON, D.C., UP AND DOWN, UP AND DOWN. SENATOR JOE BIDEN, EVERYBODY YOU NAME, PRESIDENT CLINTON, PRESIDENT BUSH. I'M TIRED, OKAY? I NEED AN ANSWER. I'M A HOMOSAPIEN AND A HUMAN BEING AND A WOMAN. CAN'T PAY YOUR BILLS WITHOUT A JOB. 

SUP. BURKE, CHAIR: SOMEONE WILL HELP YOU OVER HERE. 

LELA DUFFIE: WILL I GET ANSWERS? 

SUP. BURKE, CHAIR: IS THERE SOMEONE HERE FROM MENTAL HEALTH? RIGHT OVER HERE IN THE CORNER, THERE'S SOMEONE FROM MENTAL HEALTH. THEY'LL TALK TO YOU. THE LADY OVER THERE IN THE CORNER, SHE'LL TALK TO YOU. ALL RIGHT. WE HAVE MELA MASRESHA AND MICHAEL GARDLEY. PLEASE STATE YOUR NAME. 

MICHAEL GARDLEY: HI. MY NAME IS MICHAEL GARDLEY. I'M HERE AGAIN. I'VE BEEN HERE -- I WAS HERE ONE TIME BEFORE AND I WAS TALKING TO THIRD DISTRICT, ZEV YAROSLAVSKY, AND MIKE ANTONOVICH. WENT TO ANOTHER INVESTIGATION FOR WHAT WE ASKED FOR ON THAT DAY, WHICH I THANKED HIM FOR, BUT HE GOT STOPPED BY ZEV'S OFFICE. THERE'S TWO CHILDREN IN QUESTION THAT WE CAME AND ASKED THE COUNTY FOR HELP, AND EVERY SINCE WE CAME AND ASKED THE COUNTY FOR HELP, YOUR COUNTY HACIENDA THREATENED US, ACCUSED US, CHANGED PAPERWORK, TAKEN PAPERWORK OUT OF THE COURT DOCUMENTS, LIED TO THE COURTS, SHADED THE LAW FROM THE COURTS KNOWING WHAT ACTUALLY IS HAPPENING, ANY OF OUR PROOF THAT WE'VE HAD THAT WE'VE TRIED TO SHOW OVER THREE YEARS, WE COULD NOT SHOW. WE EVEN CAME AND TOLD YOU THERE WAS CHILD ABUSE GOING ON WITH OUR CHILDREN AND YOU TOLD US SPECIFICALLY THAT THERE WASN'T, NO CHILD ABUSE. BUT TWO WEEKS LATER, THE FOSTER MOTHER WAS ARRESTED FOR LEAVING IN AND OF OUT OF THE STATE WITH OUR CHILD AND WHEN THE DISTRICT ATTORNEY WENT TO GO GET HER, THE FOSTER MOTHER WAS OUT OF THE STATE, OUR CHILD WAS LEFT AT THE HOME BY THEMSELVES AND THE COUNTY HAD GAVE PERMISSION FOR THAT CHILD TO BE THERE BY HERSELF, AND THE COURT JUST AWARDED THE FOSTER MOTHER A RESPONSIBLE PARENT, AND WE TOLD THE COURT, SHE LET THE COURTS KNOW. THE COURTS DID NOT DO NOTHING. PERIOD. THESE CHILDREN DID NOT GET HELP. WE GOT CHARGED AS WE WERE ABUSED -- THAT WE WERE ABUSIVE PARENTS AND WE HAVE NEVER BEEN. COUNTY COUNSEL EVEN SAID TO THE COUNTY THAT WE WASN'T ABUSIVE, BUT NONE OF THAT GOT TO THE COURTS, TO THE JUDGE. NOTHING GOT TO THE JUDGE. SO WE GOT LOOKED AT AS WE WERE ABUSIVE. ZEV, I HAVE SO MUCH RESPECT FOR YOU, BEEN HAVING RESPECT FOR YOU, UNTIL THIS CASE CAME. WHEN THIS CASE CAME, I ASKED YOU FOR HELP, AND WE GOT LOOKED AT AND TOLD TO GET AWAY, AND STAND BACK. THIS GUY NAMED MICHAEL WATROBSKI TOLD ME IN FRONT OF STATE SENATOR ALARCON'S OFFICE WHEN HE WAS THE WAS THE SENATOR, STATE SENATOR, THAT I WAS CRAZY AND STUPID AND DIDN'T KNOW WHAT I WAS TALKING ABOUT AND THAT NOTHING IS GOING TO GO PAST HIS OFFICE, AND IT HASN'T WENT PAST HIS OFFICE. 

SUP. YAROSLAVSKY: WHO IS MICHAEL WATROBSKI? 

MICHAEL GARDLEY: MICHAEL WATROBSKI. 

SUP. YAROSLAVSKY: WHO IS HE? 

MICHAEL GARDLEY: HE'S BEEN WORKING FOR YOU YEARS. 

SUP. YAROSLAVSKY: I DON'T HAVE ANYBODY BY THE NAME OF MICHAEL WATROBSKI WORKING FOR ME. NEVER HAD. 

MICHAEL GARDLEY: I CAN SHOW YOU. WE TAPED IT. 

SUP. YAROSLAVSKY: JUST HANG ON A SECOND. I'M LISTENING VERY CAREFULLY TO WHAT YOU'RE SAYING. I DON'T KNOW WHAT YOU'RE TALKING ABOUT. THE FIRST QUESTION I WAS GOING TO ASK YOU, IS WHO IN MY OFFICE DID YOU TALK TO? IF THE PERSON YOU TALKED TO IS SOMEBODY BY THE NAME OF MICHAEL WATROBSKI, HE DOESN'T WORK FOR ME. 

SPEAKER: HE DIDN'T SAY THAT. 

MICHAEL GARDLEY: HE WORKED COUNTY. 

SUP. YAROSLAVSKY: PARDON? NO, YOU SAID HE WORKED FOR ME. 

MICHAEL GARDLEY: WELL, YOU'D HAVE TALKED. 

SUP. YAROSLAVSKY: YOU MEANT THE COUNTY? 

MICHAEL GARDLEY: YEAH, YEAH. 

SUP. YAROSLAVSKY: OKAY, COUNTY. BUT YOU SAID THAT MY OFFICE PUT A STOP TO YOUR COMPLAINTS. MY OFFICE DID NOT PUT A STOP TO YOUR COMPLAINTS BECAUSE NOBODY IN MY OFFICE, TO MY KNOWLEDGE, UNLESS YOU KNOW SOMEBODY IN MY OFFICE YOU TALKED TO HAS TALKED TO YOU. 

MICHAEL GARDLEY: YES YOU HAVE. YOU TALKED TO US PERSONALLY. 

SUP. YAROSLAVSKY: WELL I KNOW. YOU WERE SITTING IN MY OFFICE AND I MET YOU AND I TALKED TO YOU PERSONALLY. BUT WE DIDN'T STOP ANYTHING, SO-- 

MICHAEL GARDLEY: NO, YOU-ALL DIDN'T STOP NOTHING, THAT'S WHAT I'M TRYING TO SAY, Y'ALL DIDN'T STOP NOTHING. THAT'S WHAT WAS HAPPENING. Y'ALL BEGAN TO ABUSE OUR CHILDREN AND THEN WHEN WE GO TO THE POLICE DEPARTMENT, THE POLICE DEPARTMENT TOLD US THEY HELD A GUN OUT ON US, WE HAD A GUN PUT IN OUR FACE, TOLD US TO GET OUT OF THERE, THAT WE COULD NOT MAKE A COMPLAINT AGAINST THE COUNTY OF LOS ANGELES WHEN OUR CHILDREN WERE BEING FACTUALLY ABUSED. 

SUP. YAROSLAVSKY: I THINK WHAT I'LL DO IS STAFF WILL TALK TO YOU NOW AGAIN, BECAUSE I THINK MY STAFF SPENT A COUPLE THREE YEARS NOW SINCE THE LAST TIME WHEN YOU WERE IN MY OFFICE. WE'LL FIND OUT WHAT THE STATUS IS. I THINK THE PROBLEM IS THAT -- IS THIS A LEGAL PROCEEDING? 

MICHAEL GARDLEY: NO. 

SUP. YAROSLAVSKY: YOU SAID IT WAS GOING TO COURT. 

SPEAKER: IT'S IN COURT, BUT WE'VE NEVER ABUSED THE CHILDREN. COUNTY COUNSEL HAVE-- 

SUP. YAROSLAVSKY: I UNDERSTAND. 

MICHAEL GARDLEY: WE'RE IN COURT BECAUSE HER LAWYER SET US UP. SHE SAID WE CHANGED RECORDS AT HIS SCHOOL SIX TIMES, WHICH IS IMPOSSIBLE, SO THAT SHE COULD NOT GET VISITS AT HER HOME SO THEY CAN GET A RESTRAINING -- BY THEM HAVING A RESTRAINING ON ME, THEY COULDN'T BRING THE KIDS HOME, THEY SAID. 

SUP. YAROSLAVSKY: I UNDERSTAND YOUR DILEMMA. WE CANNOT INTERVENE -- 

MICHAEL GARDLEY: I'M NOT PART OF THIS CASE, SO YOU'RE NOT INTERVENING IN NO CASE OF THAT'S HER. [ OVERLAPPING VOICES ] 

SUP. YAROSLAVSKY: HANG ON A SECOND. 

MICHAEL GARDLEY: WHAT YOU'RE DOING TO ME IN THIS CASE, YOU SUSPENDED MY LICENSE AND FOR CHILD SUPPORT, YOU TOOK MY MEDICAL AND HEALTH, JUST LAST YEAR, AFTER ALL THREE YEARS TELLING EVERYBODY THAT I HAD NOTHING TO DO WITH THIS CASE, MICHAEL GARDLEY HAS NOTHING TO DO WITH THESE GIRLS, AND I HELPED TO RAISE THESE GIRLS. YOU ALL GOT US TOTALLY OUT OF IT, BUT THEN USING EVERYTHING OF MINE, USING MY LAST NAME AS THE KID AS MY DAUGHTER AND COURT USING YOUR LAST NAME AS SHE AIN'T NONE OF MINE. 

SUP. YAROSLAVSKY: OKAY. HANG ON. WE'LL LOOK INTO THAT BECAUSE THAT'S NEWS TO ME, BUT THAT'S NOT IN MY OFFICE. YOU'RE REFERRING TO THE COUNTY. 

MICHAEL GARDLEY: YES, BUT YOUR COUNTY COUNSEL IS ALLOWING YOU TO HAVE -- 

SUP. YAROSLAVSKY: I UNDERSTAND MR. GARDLEY. HANG ON A SECOND, I CAN HANDLE THIS. I UNDERSTAND WHAT YOU'RE SAYING. I JUST WANT, SINCE THIS GOES OUT OVER THE AIRWAVES, I WANT TO MAKE SURE THAT WHAT YOU SAY IS SPECIFIC, AND I DON'T WANT -- [ OVERLAPPING VOICES ] 

MICHAEL GARDLEY: THE COUNTY STOLE OUR CHILDREN -- 

SUP. YAROSLAVSKY: I UNDERSTAND THAT THAT'S YOUR POINT OF VIEW. 

MICHAEL GARDLEY: WE CAME TO YOUR DEPARTMENT FOR HELP AND OUR CHILDREN HAVE RAN AWAY. WE WAS TAKEN A PARENTING CLASS. THAT PARENTING CLASS GAVE US LETTERS TO GO TO YOUR COURTS TO ASK FOR HELP. ONCE WE GOT TO YOUR COURTS, YOUR COURTS AND THE COUNTY AND COUNTY COUNSEL CHANGED EVERYTHING AROUND LIKE WE ABUSED THE CHILDREN. WE NEVER ABUSED THEM. FINALLY WHEN THE FEDERAL GOVERNMENT GOT INVOLVED AND ASKED THEM WHAT HAPPENED, HER LAWYER TOLD THEM, OH, THIS IS A CUSTODY BATTLE. WHERE DID CUSTODY BATTLE COME FROM WHEN YOU WAS TRYING TO GET US ON ABUSE? 

SUP. YAROSLAVSKY: ALL RIGHT. I'M GOING TO HAVE MY STAFF TALK TO YOU -- 

MICHAEL GARDLEY: BUT THAT WAS SUPPOSED TO HAPPEN THREE YEARS ARE GONE. YOU CAN'T GET THE KIDS BACK. WE CAN'T GET OUR MONEY BACK. [ OVERLAPPING VOICES ] 

MICHAEL GARDLEY: I'M HIDING FROM L.A.P.D. RIGHT NOW, BECAUSE L.A.P.D. TOLD ME, IF I'M GOING TO MAKE ANY REPORT AT THEIR OFFICE, THAT I WOULD GO TO JAIL. I CAN'T EVEN DO IT BECAUSE WE GOT THREATENED BY THE COUNTY, WE HAVE TO GO MAKE A REPORT. THE POLICE DEPARTMENT TOLD US BECAUSE THEIR SHAREHOLDERS OF YOURS THAT THEY WILL REFUSE TO MAKE ANY REPORT. RIGHT NOW I GOT A CHILD MISSING BECAUSE I CALLED THE COUNTY, LET THE COUNTY KNOW WHAT'S HAPPENED I THINK THEY TOLD ME TO GO TO THE POLICE DEPARTMENT. THE SAME THING THAT HAPPENED WITH HER. [ OVERLAPPING VOICES ] 

MICHAEL GARDLEY: OUR CHILDREN IN LIMBO ALL OVER THE PLACE, Y'ALL ARE TELLING US WE'RE BAD PARENTS, THIS WOMAN HASN'T SEEN HER CHILDREN. THE COURTS TELLING US THAT WE'RE DOING BAD THINGS IN WEIRD PLACES, WHEN WE'RE SITTING IN STATE SENATOR'S OFFICES ALL DAY. THEY TELL US WE WERE IN LANCASTER SAID WE CHANGING RECORDS. AND WE CAN PROVE, BUT NOBODY COMING OUT WITH INVESTIGATORS, THEY'RE TELLING US TO RIGHT IT OFF. 

SUP. YAROSLAVSKY: DO YOU LIVE IN LANCASTER? 

MICHAEL GARDLEY: NO. THEY'RE CHARGING HER CHILD SUPPORT AND THEY SAID -- 

SUP. YAROSLAVSKY: ALL RIGHT. I'M GOING TO -- [ OVERLAPPING VOICES ] 

MICHAEL GARDLEY: AND RIGHT NOW TODAY THEY'RE CHARGING HER AND WE'RE ABOUT TO LOSE OUR PLACE. WHAT DO YOU MEAN? WE'VE BEEN COMING TO YOU -- 

SUP. BURKE, CHAIR: SIR? 

MICHAEL GARDLEY: I CAME TO YOU AT MANY MEETINGS THAT I'VE BEEN AT THAT YOU'VE BEEN AT AND I'VE TALKED TO YOU. YOU KNOW WHAT I'M SAYING? WE'VE BEEN TO YOUR OFFICE, WE'VE TALKED TO YOU. YOU KNOW WHAT I MEAN? WE'RE NOT NO BAD PARENTS. WE'RE NOT NO ABUSIVE PARENTS. YOUR COUNTY HAS SET US UP, AND WE CAN PROVE IT, FROM THE VERY BEGINNING TO NOW. WE HAVE LEGISLATION PEOPLE WHO IS TELLING US THAT THEY'RE SUPPOSED TO BE HELPING THE COUNTY BUT THEY'RE TRYING TO HELP US NOW BECAUSE THEY'RE JUST NOW STARTING TO SEE FROM THE VERY BEGINNING LIKE WE'VE BEEN SAYING, WE'VE BEEN SET UP. 

SUP. BURKE, CHAIR: WOULD YOU LET HER SPEAK NOW? BECAUSE YOUR TIME HAS EXPIRED. PLEASE STATE YOUR NAME. 

MELA MASRESHA: MELA MASRESHA. AND I'LL JUST ADD MICHAEL HAD JUST TALKED ABOUT WAS -- YEAH, WE TALKED TO SUPERVISOR YAROSLAVSKY IN PERSON, HE TOOK US TO HIS CHILDREN SERVICES DEPUTY, WENDY ERIN, IN DECEMBER 2005. TWO MONTHS LATER, WENDY ERIN TOLD US, AFTER TALKING TO MICHAEL WATROBSKI, W-A-T-R-O-B-S-K-I THAT THERE WAS NOTHING SHE CAN DO FOR US. YOU JUST SAID THERE IS STILL AN INVESTIGATION. I KNOW NOTHING ABOUT IT. IS THAT WHAT YOU JUST SAID? 

SUP. YAROSLAVSKY: I DIDN'T SAY THAT. I DIDN'T SAY THAT. I DIDN'T SAY THAT. IT MAY BE VERY POSSIBLE. I REMEMBER WHEN YOU CAME INTO MY OFFICE. AND IT MAY BE THAT THERE WAS NOTHING SHE COULD DO. 

MELA MASREHA: YEAH, THERE IS. EXPLAIN TO ME SOMETHING. 

SPEAKER: I WAS IN THE AVARCON'S OFFICE WITH US AND Y'ALL WOULDN'T EVEN TALK TO THEM. Y'ALL DISCREDITED THEM, AND THE COUNTY TOLD THEM IF THEY'D HELP US -- 

SUP. YAROSLAVSKY: SHE'S THE ONE THAT'S TALKING NOW. SHE'S THE ONE THAT'S TALKING NOW. 

SUP. BURKE, CHAIR: YOU HAVE -- HOW MANY CHILDREN DO YOU HAVE? 

MELA MASRESHA: TWO. 

SUP. BURKE, CHAIR: AND WHERE ARE THE CHILDREN AT PRESENT? 

MELA MASRESHA: WITH THE COUNTY SOMEWHERE. THEY DON'T TELL US NOTHING. 

SUP. BURKE, CHAIR: HAVE YOU BEEN TO COURT? 

SPEAKER: YEAH. 

SUP. BURKE, CHAIR: YOU HAVE BEEN? 

MELA MASRESHA: YEAH. 

SUP. BURKE, CHAIR: SO WHAT WE NEED TO ASK YOU TO DO IS TO SPEAK TO THE PERSON FROM CHILDREN AND FAMILY SERVICES AND WE'LL FIND OUT EXACTLY WHAT THE COURT DID. WE HAVE NO AUTHORITY OVER ASSIGNING CHILDREN TO FOSTER HOMES OR DETERMINING WHO IS ABUSIVE. WE ARE NOT EVEN ALLOWED -- 

MICHAEL GARDLEY: BUT Y'ALL -- 

SUP. BURKE, CHAIR: WAIT A MINUTE, SIR. WE ARE NOT EVEN ALLOWED TO GET ALL OF THE REPORTS, BUT WHAT WE CAN DO IS CONTACT CHILDREN AND FAMILY SERVICES AND THEY CAN FIND OUT EXACTLY THE STATUS, WHETHER OR NOT -- WHERE YOUR CHILDREN ARE OR WHETHER OR NOT THEY, FOR SOME REASON, YOUR RIGHTS HAVE BEEN TERMINATED, BUT WE CAN'T TELL THAT, BUT THEY CAN FIND OUT. SOME OF OUR STAFF CAN FIND OUT FROM CHILDREN AND FAMILY SERVICES, BECAUSE YOU SEE, WE DON'T GO INTO THE COURT. WERE YOU PRESENT IN THE COURT WHEN THEY HEARD YOUR CASE? 

MELA MASRESHA: WAS I WHAT? 

SUP. BURKE, CHAIR: WERE YOU PRESENT IN COURT WHEN THEY HEARD THE CASE REGARDING THE CHILDREN? 

MELA MASRESHA: THIS CASE HAS BEEN IN COURT FOR THREE YEARS. 

SUP. BURKE, CHAIR: HAVE YOU BEEN TO COURT DURING THAT TIME? 

MELA MASRESHA: I'VE BEEN TO COURT. BUT I'M NOT TALKING ABOUT COURT. COURT IS NOT THE ISSUE HERE. 

SUP. BURKE, CHAIR: WELL, THE CHILDREN'S COURT IS THE ONLY ONE WHO CAN MAKE A DETERMINATION OF WHETHER OR NOT YOU HAVE YOUR CHILDREN. DO YOU UNDERSTAND THAT? 

MELA MASRESHA: YEAH, BUT I HAVE SOMETHING TO SAY TO THAT. 

SUP. BURKE, CHAIR: OKAY. 

MELA MASRESHA: YOU GO TO COURT, YOU HAVE THE RIGHT TO HAVE AN ATTORNEY. I WAS APPOINTED SOMEBODY AND THE PERSON, HIS NAME IS ON PAPERWORK, BUT IF THE ATTORNEY DOESN'T DO ANYTHING, THERE IS NO REPRESENTATION. THE COURT IS A COUNTY COURT. YOU ARE THE COUNTY SUPERVISORS. THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES IS A COUNTY AGENCY. YOU ARE SUPERVISING THE COURT AND THE D.C.F.S. AND YOU'RE TELLING ME YOU CAN'T DO NOTHING? WHY ARE YOU CALLED SUPERVISORS? 

SUP. BURKE, CHAIR: OKAY. ALL RIGHT. WE'LL JUST LET YOU TALK TO THIS PERSON OVER HERE. 

SUP. YAROSLAVSKY: THIS IS OVER. 

MELA MASRESHA: WAIT A MINUTE. ONE MORE THING. 

MICHAEL GARDLEY: THE KIDS' LAWYER MOVED OVER TO HER LAWYER DEPARTMENT AND THEY DIDN'T TELL HER THAT THEY DID THAT. THEN WHEN LEVINE'S OFFICE CALLED, ASSEMBLY MEMBER LEVINE'S OFFICE CALLED TO SEE WHERE THE LAWYER WAS. THAT LAWYER TOLD HER, AFTER GOING TO COURT FIVE OR SIX TIMES ALREADY, THAT HE REFUSED TO GO TO COURT FOR HER AGAIN BECAUSE HER CHILDREN'S LAWYER IS NOW WORKING FOR HIS DEPARTMENT AND BEEN THEN WORKING FOR HIS DEPARTMENT FOR OVER SEVEN OR EIGHT MONTHS. 

SUP. BURKE, CHAIR: ALL RIGHT. SOMEONE OVER HERE FROM CHILDREN AND FAMILY SERVICE WILL TALK TO YOU AND TRY AND GET ALL THE FACTS STRAIGHT. 

MELA MASRESHA: WE'RE NOT HERE TO TALK TO THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES -- [ OVERLAPPING VOICES ] 

SUP. BURKE, CHAIR: THANK YOU VERY MUCH. ALL RIGHT. THANK YOU VERY MUCH. THANK YOU. OKAY. JUST MAKE YOUR POINT -- SIR? OKAY, SIR? OKAY. LET ME TELL YOU, I'M GOING TO ASK YOU TO LEAVE THE PODIUM. WOULD YOU MIND? YOU'VE TERMINATED. I'M NOT THREATENING YOU. 

SPEAKER: (OFF-MIKE). 

SUP. BURKE, CHAIR: OKAY. THANK YOU. THANK YOU. ALL RIGHT. 

SPEAKER: (OFF-MIKE). YOU'RE NOT GOING TO LISTEN TO US, THOUGH. (OFF-MIKE). 

SUP. BURKE, CHAIR: WE HAVE BEEN LISTENING TO YOU. 

SPEAKER: YOU'RE NOT LISTENING. L.A.P.D. PULLING OUT GUNS ON US... (OFF-MIKE). (CONTINUES TALKING OFF-MIKE). (YELLING). 

SUP. BURKE, CHAIR: IS THERE ANYONE ELSE? 

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NUMBER CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE; ITEM CS-2, CONSIDERATION OF DEPARTMENT HEAD PERFORMANCE EVALUATIONS, ITEM NUMBER CS-3, CONFERENCE WITH REAL PROPERTY NEGOTIATORS WILLIAM T. FUJIOKA AND HAMMES COMPANY WITH RESPECT TO MARTIN LUTHER KING JR. HARBOR HOSPITAL WILL BE CONTINUED TWO WEEKS TO MAY 20TH, 2008. PLEASE BE ADVISED THAT THE BOARD OF SUPERVISORS WILL HOLD A SPECIAL MEETING TO HEAR TESTIMONY RELATING TO THE 2008/2009 PROPOSED BUDGET ON WEDNESDAY, MAY 7TH, 2008, AT 9:30 A.M. THE NEXT REGULAR MEETING OF THE BOARD WILL BE HELD ON TUESDAY, MAY 13TH, 2008. THANK YOU. 
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